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Eclipse awarded JPMorgan "Best 
Deployment of Eclipse technology 
in an enterprise" at ECLIPSECON, 
Mar. 6, 2007 
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Eclipse Community Awards Winners Announced 
Awards Recognize Top Individuals and Technologies in the Eclipse Community 

ECLIPSECON 2007, SANTA CLARA, Calif., March 06, 2007+The Eclipse Foundation today announced the 

winners of its annual Eclipse Community Awards, which recognize the top individuals, products and organizations 

bttps://cc:lipse.org/orglpn:ss-rclcaseJ20070306eclipsecouununityawards.php[O 1/15/2015 8:37:48 AM] 
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in the Eclipse community. Recipients were honored at an awards ceremony yesterday on the opening day of 

EclipseCon 2007. 

The Individual Awards acknowledge people that have given time and resources to make Eclipse a better 

community. Winners were selected by their peers in an online vote. The selection of the +Top Newcomer 

Evangelist+ award was based on the individual that answered the most questions raised on the 

eclipse.newcomer newsgroup. 

• Top Ambassador: Chris Aniszczyk. Finalists in this category are Alex Blewitt and Doug Schaefer. 

• Top Contributor: Kimberley Peter and Tom Schindl (tie). Finalists in this category are Eugene Kuleshov 

and Philippe Ombredanne. 

• Top Committer: Ed Merks. Finalists in this category are Mik Kersten and Thomas Watson. 

• Top Newcomer Evangelist: Daniel Megert. Finalists in this category are Hendrik Maryns and Eric Rizzo. 

The Technology Awards recognize both Eclipse-based open source projects and commercial products. Winners 

were selected by a panel of judges from the Eclipse community. Nominated RCP applications and developer tools 

were evaluated on their user interfaces, innovation and comprehensiveness. Organizations competing for the 

+Best Deployment of Eclipse Technology in an Enterprise Technology+ award were evaluated based on 

number of Eclipse projects being used, scale of applications being deployed and the scope of deployment. 

• Best Open Source RCP application: PSICAT (http://portal.chronos.org/psicat-site). The finalists are 

EclipseTrader (http://eclipsetrader.sourceforge.net) and RSSOwl (http://www.rssowl.org). 

• Best Commercial RCP application: TIBCO Business Studio 

(http://www.tibco.com/devnet/business_studio). The finalist is lvis Technologies xProcess 

(http://www.ivis.com/public/products/xprocess). 

• Best Open Source Eclipse-based Developer tool: eclipse-cs Checkstyle Plugin (http://eclipse­

cs.sourceforge.net). 

The finalist is EciEmma (http://www.eclemma.org). 

• Best Commercial Eclipse-based Developer tool: QNX Momentics IDE 

(http://www.qnx.com/products/development)). The finalist is Adobe Flex 2.0 
(http://www.adobe.com/products/flex). 

• Best Deployment of Eclipse technology in an enterprise: JPMorgan Chase 

(http://www.jpmchase.com). 

About the Eclipse Foundation 

Eclipse is an open source community whose projects are focused on providing an extensible development 

platform and application frameworks for building software. Eclipse provides extensible tools and frameworks that 

span the software development lifecycle, including support for modeling, language development environments for 

Java, C/C++ and others, testing and performance, business intelligence, rich client applications and embedded 

development. A large, vibrant ecosystem of major technology vendors, innovative start-ups, universities and 

research institutions and individuals extend, complement and support the Eclipse Platform. 

The Eclipse Foundation is a not-for-profit, member supported corporation that hosts the Eclipse projects. Full 

details of Eclipse and the Eclipse Foundation are available at www.eclipse.org. 

### 

All company/product names and service marks may be trademarks or registered trademarks of their respective 

companies. 

https://eclipse.org/org/press-release/20070306cclipsecommunityawards.php[OI/15/2015 8:37:48 AMJ 
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Press Contact 

John Moran or Lori Kroll 

Schwartz Communications 

781-684-0770 
eclipse@schwartz-pr.com 

https:l/ec:lipse.orglorg/press-rclease/20070306eclipseconummityawards.php[O 1/15/2015 8:37:48 AM] 
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JPMorgan Raises the Bar 

for Banking Applications 

JPMorganO "We wanted to 

A 
s one of the world's 
leading financial 
institutions, JPMorgan 

tracks changes in the world's 
financial markets 24 hours a 

day to bring their customers 
competitive retail, 
investment, commercial, and 
mergers and acquisitions 
bankjng services. With 

develop an -----
_. 

alternative to 

spreadsheets 

as a platform 
needs of its employees, it also 
has real drawbacks that 
become more significant as 
markets globalize and their IT 
environments become more 
complex. 

for modeling 

applications." 

offices around the world and 
many highly specialized IT requirements for 
critical business functions such as inventory 
management and price forecasting, 
JPMorgan has built up a wide assortment of 
custom-built applications designed to meet 
specific needs. 

Islands of Development 
Such organic development, often at the 
departmental or branch level, is common in 
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For example, since many 
applications have been written to solve 
narrowly defined problems, it is often 
difficult to reuse their functionality to solve 
similar problems in new software 
development. 

The speed with which an application can be 
deployed in the front office to support a new 
business opportunity can have a significant 
impact on the value of the new offering to 
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Snapper and One Bench provide an alternative to spreadsheets for real time grid based 
applications. 

the financial services industry, and has 
served JPMorgan well for many years. 

But while decentralized software 
development gives JPMorgan valuable 
creative flexibility to meet the specialized 

the firm. Rapidly deployed, tactical systems 
often result in cases where the new product 
offering takes off. the scaling of these 
systems from low volume niche 



Case 1:16-cv-00281-UNA   Document 1-4   Filed 04/20/16   Page 6 of 83 PageID #: 686

applications, into industrial strength strategic 
platforms can be a real challenge. 

A case in point is large number of pricing 
applications developed as Excel 
spreadsheets that perform and display price 
calculations on the trader's desktops, the 
applications shortcomings were becoming 
more apparent as the demands on them 
increased. As Bruce Skingle, Distinguished 
Engineer with the Investment Bank 
Technology group at JPMorgan relates, 
"Spreadsheet applications are quick to 
deploy and can be understood and moditied 
on the trading floor. This can be a powerful 

Bridging Developers 
It was against this backdrop that the 
Investment Bank Technology group started 
work on a replacement for their existing 
systems. More than a re�write of the 
existing spreadsheets, they wanted to lay a 
solid foundation for enhanced security, 
auditing, scalability, interoperability and, 
above all, reusability. To achieve this, 
Skingle understood that they needed to 
produce a generalized platform in which this 
and other new applications could be 
extended, reused and shared. As he 

tool for a novel product, 
but it opens up a host of 
control issues. With more 
mature products the need 
for consistent pricing and 
risk management across 
regions becomes more 
important." It was also 
difficult to back up data 
associated with these 

"We needed to 

custom copies. 

know that we 

could recover in a 

hurry if an update 

went wrong. 

Having 

applications down 

for any amount of 

time on the 

Other problems noted by 
Skingle included general 
performance and reliability 
issues. 

explains, "We wanted to 
develop an alternative to 
spreadsheets as a platform 
for modeling applications 
and at the same time allow 
for greater abstraction and 
reuse across other projects. 
As a tool for building a new 
model, a spreadsheet is an 
excellent tool, but by the 
time a product is traded the 
official models developed 
by the Quantitive Research 
group are delivered as 
libraries, and the 
spreadsheet is being used as 

trading floor is not little more than a .dll 
Throughout the bank, other 
groups faced similar 
problems. For example, 

an option." container and a grid based 
GUl." To tllis end Skingle 
envisioned that the 

building financial applications to take 
advantage of new market conditions 
involved a cumbersome combination of 
Excel and C++; and took too long to build. 
Similarly, other groups faced the challenge 
of maintaining the many applications for 
entering reference data that had been 
developed in  isolation over the years, 
duplicating functionality and code. Up to ten 
years old and written in C++, they did not 
share functionality and were burdensome to 
maintain. 

2 

spreadsheet-based GUI and code for 
common tasks like single sign-on and 
logging would be openly available for 
developers using the new environment, 
leaving application developers free to focus 
on the business problem. 

The result was One Bench, a platform for 
developing and delivering custom banking 
applications, starting with Fuse, their new 
bond trading application. 

Fuse is a perfect example of a rich client 
banking application. Receiving a constant 
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stream of market data on bond trading 
prices, the application consolidates disparate 
sources to traders in a familiar grid. This 
data can then be used to help traders identify 
trends and perform 'what-if analysis. The 
designers knew that, as a rich client 
application, Fuse consumes data in streams 
that could be shared across other bank 
applications. They envisioned a GUI 
framework, called Snapper, as another 
shared component that would run in the One 
Bench environment and into which 
developers could snap applications to 
provide a consistent user view to similar 
data. 

EIS is being developed on One Bench by the 
IB Technology Exotics & Hybrids group to 
consolidate the large number of systems that 
have been set up over the years for entering 
reference data. Up to ten years old and 
written in C++, they did not share 
functionality and were burdensome to 
maintain. As Martin Game, Vice President 
with the IB Technology Exotics & Hybrids 
group relates "Moving our first project to 
Eclipse and One Bench took several months, 
as we added shared functionality to the 
environment, but future work will benefit 
from that investment and make us far more 
efficient." Mr. Game expects that they will 
have several more EIS reference data 
applications ported to One Bench by the end 
of the year. 

Similarly, QTrade was developed 
independently by the Exotics & Hybrids 
group in the bank to solve the problem of 
difficult and slow to write financial 
applications. Banks produce new 
applications on very short notice to take 
advantage of financial trends. Previously, 
each new application involved a 
combination of Excel and customized C++ 
coding, with a tum-around time of over two 
weeks. 

3 

JPMorgan evaluated several options for the 
development of One Bench, but the final 
choice came down to Java/Swing or Eclipse 
RCP. After careful evaluation, RCP 
emerged as the better alternative. RCP is 
designed from the ground up as a plug-in 
platfonn that will allow One Bench 
applications to be written as Eclipse plug­
ins. 

Hitting the Ground Running 
Support for native windowing was also a 
significant advantage. Applications built for 
One Bench wiH meet users' expectations for 
familiarity. Taking advantage of One Bench 
and Eclipse, the QTrade developers were 
able to develop a flexible and easy-to-use UI 
based on SWT and XML. Users can 
structure new exotic financial products using 
simple drag-and-drop operations to add 
libraries to a canvas and add business logic, 
and development times are reduced from 
weeks to hours. 

GraphicaJ performance was another area 
where RCP excelled. Previous development 
of Swing based applications had involved 
significant efforts to get performance from 
the very functional table control with large 
data sets and rapid update rates. A Snapper 
based proof of concept has demonstrated 
that an SWT-based table is capable of 
maintaining a 400,000 row data set with 
1000 updates per second without any special 
coding tricks or unusual hardware. The m 
Technology Exotics & Hybrids group's EIS 
project saw similar benefits from RCP' s 
performance. 

Delivering Mission Critical 
Applications 
Since the long-term plan is that One Bench 
will become the platform of choice for 
developers of desktop applications within 
JPMorgan, the logistics of maintenance 
were critical. For instance, not all users need 
or are entitled to the same applications, or 
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specific functionality within an application. 
Roll out and updates had to be automated 
based on a user's credentials. Equally 
important, when deploying multiple 
applications to the same Java Virtual 
Machine, there is always the risk that a 
problem with updates to one application 

would crash one or more critical 
applications. "We needed to know that we 
could recover in a hurry if an update went 
wrong. Having applications down for any 
amount of time on the trading 1loor is not an 
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JPMorgan's Single Sign On system was 
originally designed for web-based 
applications and they can integrate this 
system with One Bench so that the system 
knows exactly what updates to apply to each 
desktop. Advanced features such as the 
ability to roll an application back to a 
previous release state, are also critical. 
Skingle explains that ·'banks are very 
conservative about any new technology, and 

sharing applications on a JVM is a real 
concern. Automated roll-backs in the 
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JPMorgan used SWT and XML to develop the easy·to-use QTrade application authoring 
tool. Users drag components to a canvas and apply business logic to develop applications 
quickly and without programming. 

option." 

These requirements made Eclipse's Update 
Manager central to their strategy for One 
Bench and the components and applications 
such as Snapper, EIS and QTrade that run 
on il. Accessing the Update Manager's API 
directly, they can take complete 
programmatic contTOI of the update process. 
For example, they by-pass end user input, 
performing all application updates silently. 

4 

Eclipse Utxlate Manager reduce our risk and 
makes the open One Bench approach 
feasible." QTrade applications, for example, 
are saved as XML files, and these are easily 

deployed out to desktops using the Eclipse 
Update Manager. As Paul Sampat, Vice 
President wilh the IB Technology Exotics & 
Hybrids group explains, "The One Bench 
p.lus Update Manager combination lets us 
develop and depfoy quickly while reducing 
om· risk." 
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Indeed, with the Update Manager, an 
application can be updated globally over a 
weekend. If a problem is discovered when 
employees start work on the following 
Monday in the Far East, the situation can be 
cotTected immediately, and the rest of the 
global workforce will never know there was 
an issue. 

Eclipse RCP gives JPMorgan what they 
need: a plug-in friendly environment that 
will encourage efficiency and lower costs, 
and the control to ensure that software can 
be managed effectively. 

All of these development groups bad 
independently identified Eclipse as their 

5 

environment of choice. When they learned 
of the One Bench initiative, they each knew 
that it would make their tasks easier and 
make sense for JPMorgan. One Bench 
gives them a head start for their own 
requirements, and as they contribute 
components, they make it a more attractive 
solution for developers throughout the bank. 

With One Bench in place, they expect their 
developers to develop the banking world's 
next killer-applications. 

Ron Stone is a technology writer and 
content management consultant based in 
Ottawa, Canada 
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The Members of Eclipse 

• 191 members as of September 9, 2008 
• 23 Strat&gic Members 

• 917 committers, representing 50+ organizations O JPMorganChase 
Strategic Members 
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IBM Eclipse Foundation Members, page I, prepared as ofSep. 09,2008 and reported to the 
Board of Directors on Sep. 17, 2008. 

See The Eclipse Foundation (Sep. 09, 2008). Membership Logos [Board minutes]; See also The 
Eclipse Foundation (Sep. 17, 2008). The Members of Eclipse, Minutes ofthe Eclipse Board 
Meeting, Sep. 17, 2008; 
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Board of directors 

Press release 

Eclipse Names Founding Board of Directors 
• Board Expands to 12 Members as "Committer" and "Add�ln Provider" Representatives are Elected 

ASHEVILLE. NC�arch 3, 2004-Four new members of the Eclipse Board of Directors, representing the 
organization's Open Source project community and commercial supporters, were announced today. Newly 
elected, Todd Williams (Genuitec, LLC), John Wiegand (Eclipse Project Lead, IBM); Rich Main (SAS). and 
Bjorn Freeman-Benson (University of Washington) join the board, which already includes Ronald Ingman 
(Ericsson), Michael J. Rank (Hewlett Packard), Dave Thomson (IBM), Jonathan Khazam (Intel). Jim Ready 
(MontaVista Software). Dan Dodge (QNX Software Systems Ltd.), Michael Bechauf (SAP AG) and Boris 
Kapitan ski (Serena Software). This establishes the founding twelve-member Eclipse Board of Directors, 
responsible for approving Eclipse strategy, development roadmaps and release plans, and establishing 
organization policy. 

"Genuitec is very pleased to be able to continue our strategic involvement with the Eclipse Foundation," said 
Todd Williams. vice president of technology for Genuitec. Through our membership in the Board of 
Directors, we will work to expand the Eclipse ecosystem in its current market segments (integrated 
development environment users, add�in providers and rich client platform adopters) while fostering its 
adoption in additional market segments." 

Bjorn Freeman-Benson said, "I'm honored to have been elected by the committers as one of their two 
representatives on the Board. I look forward to working with the rest of the Board to expand the Eclipse 
community by encouraging low�verhead ways for people to contribute." 

"The rapid and broad adoption of Eclipse technology is proof to a very strong market demand for open 
standards and common platforms worldwide," said Jim Ready, chief executive officer and president, 
MontaVista Software. "I am honored to serve on the Eclipse Board of Directors. MontaVista Software has 
proudly demonstrated our commitment to Eclipse. by adopting it as a strategic development framework, 
through its founding membership in Eclipse, and with ongoing contributions to Eclipse technology. We 
continue to look forward to being part of this important initiative." 

"I look forward to serving on the Eclipse Foundation Board of Directors," said Rich Main, director of Java 
development environments at SAS. "SAS is committed to working with the Eclipse community to strengthen 
the growth and adoption of Eclipse. This will be a critical year for the Eclipse Foundation as we strive to 
move from an organization that is focused primarily on the development community to one that is an 
increasingly attractive option for end-user consumers, as well. We intend to work in partnership with the 
entire Eclipse community to make this transition as smooth and successful as possible." 

Originally a consortium that formed when IBM released the Eclipse Platform into Open Source, Eclipse has 
now been incorporated as an independent, not-for-profit organization. Tangible support from 58 member 
companies enables Eclipse to host and nurture 19 Open Source projects that originated in commercial and 
academic contexts. In just 2 years, this community has professionally delivered the most broadly deployed 
and fastest growing universal tools integration platform in history. All technology and source code provided 
within this fast-growing ecosystem remains openly available and royalty-free. 

http://www.eclipse.org/org/press-release/mar32004directorspr.html 4/8/2016 
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Worldwide, Eclipse membership represents individual contributors and large and small companies with 
interests ranging from embedded computing and Linux through traditional enterprise class information 
technology. 

"With constitution of our founding Board of Directors, Eclipse is now traveling on the industry-neutral path 
that is critical for integration technology," said Skip McGaughey, spokesperson for Eclipse. ''This launches 
the most significant step forward in the evolution of Eclipse as an organization. For the Open Source 
development community we're establishing a support base that will strengthen the projects and expand a 
powerful reusable architecture. For commercial and academic users of Eclipse technology, this means a 
more open management process and improved choices in a stable and reliable environment." 

About Eclipse 

A vibrant open eco-system has formed around royalty-free Eclipse technology, a universal platform for tools 
integration. Eclipse based tools give developers freedom of choice in a multi-language, multi-platform, multi­
vendor environment. Eclipse provides an award winning plug-in based framework that makes it easier to 
create, integrate and utilize software tools, saving time and money. By collaborating and exploiting core 
integration technology, tool producers can leverage platform reuse and concentrate on core competencies to 
create new development technology. The Eclipse Platform is written in the Java language and comes with 
extensive plug-in construction toolkits and examples. It has already been deployed on a range of 
development workstations including Linux, QNX, Mac OS X and Windows-based systems. Release 
distribution downloads, a full description of the Eclipse community and white papers documenting the design 
and use of the Eclipse Platform are available at http://www.eclipse.org. 

Media contact 

Barbara Stewart 
Patterson and Associates 

480-488-6909 
barbara@patterson.com 

Brand or product names are registered trademarks or trademarks of their respective holders. Java and all 
Java--based trademarks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United 
States and other countries. 

http://www.eclipse.org/org/press-release/mar32004directorspr.html 4/8/2016 
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Abridged Minutes of the Board Meeting of the Eclipse 
Foundation, Inc. 

Attendees 

Michael Bechauf (SAP) 
Mark Cogins (Actuate) 

December 8, 2004 

Bjom Freeman-Benson (Committer representative) 
Boris Kapitanski (Serena) 
Rich Main (Add-In Provider representative) 
Joel Clinkenbeard representing Jonathan Khazam (Intel) 
Dave Thomson (IBM) 
John Wiegand (Committer representative) 
Todd E. Williams (Add-In Provider representative) 
Mike Milinkovich (Executive Director) 

Not in attendance 

Dan Dodge (QNX) 
Par Emanuelsson (Ericsson) 
Michael Rank (HP) 
Jim Ready (MontaVista) 

Location: American Airlines Admiral Club at O'Hare Airport. 

Board Items: 

A number of resolutions were reviewed and approved by the Board. These resolutions included: 

• The minutes of the September 301h meeting and the November 171h phone call were 
approved. 

• The Board replaced the "Legal Advisory Committee" with a new "IP Advisory Committee" 
chaired by Dave Thomson of IBM and including Rich Main (SAS) and Michael Bechauf 
(SAP). 

• Mark Coggins (Actuate) will replace Dave Thomson (IBM) on the Finance Committee. 
• Eclipse will issue trademarks and related usage guidelines for Eclipse Foundation 

Member, Built on Eclipse, Eclipse Ready. 
• The CPL to EPL conversion process continues. But not unexpectedly the Foundation 

has been unable to locate each and every contributor to the projects over the past three 
years. In order to ensure the intellectual property of Eclipse is of the highest quality, the 
EMO will require the PMCs to re-implement any functionality which the EMO is unable to 
have explicitly re-contributed under the Eclipse Public License. 

Eclipse Working Groups 

There have been a number of requests to the EMO to create ad hoc working groups of the 
members. The Board authorized the EMO to support the creation of Eclipse Working Groups 
under the following guidelines: 

• Any member can request the creation of a working group 
• The EMO will facilitate the request where and as possible (e.g. we may have resource 

constraints) 
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• Upon the request of the initiating Member(s) the EMO will host the phone calls or other 
meetings 

• Each WG must have a defined scope and purpose 
• All meetings must be documented with abridged minutes and minutes are to be made 

available to any interested Member 
• The membership of any WG must be open to all Members and their employees, etc. 
• WG's are not empowered to act for the Foundation or to speak on its behalf without the 

permission of the EMO 
• WG's must comply with the Foundation's Bylaws and policies (including IP and anti-trust) 
• WG's can refer to themselves as "Eclipse Working Group for XXX" or "XXX Working 

Group" 

Commltter Community Issues and Update 

Bjorn Freeman-Benson and John Wiegand raised a number of Issues of interest to the Committer 
community at Eclipse. 

• Although the infrastructure is improving, the transparency of the EMO plans is not 
sufficient. Although there is recognition that the EMO is making improvements in various 
processes (e.g. creating a project, provisioning a committer}, the EMO has not provided 
status reports or progress reports, and the documents are not available in the newgroups 
and mailing lists. 

• It is not sufficient for the EMO to just get these processes in place. How it gets done is 
just as important. 

• Bjorn Freeman-Benson requested input from the committer community and has created a 
prioritized list of committer requests for improvement in the Eclipse infrastructure. This list 
can be found at http://www.eclipse.org/webtools/committersllist.html. 

Committer Community 
Community Infrastructure Requests 

• We asked tho community for a prioritized list of requests and we 
received responses from more I han 1/3"1 of tho cornrnitters. The 
list and the results can be found at 
htt ://www.ocli Jso.or /wobtoolslc ommittors/list.htrnl. 

• Number one on the list. by a large margin, was self managom�nt 
of Infrastructure. Infrastructure admtnts{r atron channels are defined 
by the Eclipse development process. The committors and PMCs 
would like to automate these processes to streamline the 
interactions (and facilitate record keeping): 

- Self administration of projoct·spociflc bugzilla features including 
adding and removing components, ch anging component owners, 
deciding whether to use NEW or UNCONFIRME D. etc. 

- Self <tdministration of mailing lists rncluding creating and removing 
hsts. enable moderatron, ole. 

- Self administration of projoct·spocific CVS incfudtng creating top-level 
directories. 

- Self management of project website including the removal of frames, 
the uso of solVer-side dynamic content (PHPs/JSPs ), wikls, and 
l1ierarcl1icol blogs for promoting nows. 
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As filed with Ute Securities and Exchange Commission 011 May 16, 2012 
Registntion No. 333-179287 

UNITED STATES 

SECURITIES AND EXCHANGE COMMISSION 

Delaware 
(State or other jurisdiction of 
incorpor.�tion or organization) 

Washington, D.C. 20549 

Amendment No. 8 to 

Form S-1 

REGISTRATION STATEMENT 
Under 

Tlte Securities Act of 1933 

Facebook, Inc. 
(Exact name of RegistrAnt as SJICCified in its charter) 

7370 
(Primary Standard Industrial 
Classification Code Nu mber) 

Facebook, Inc. 
1601 Willow Road 

Menlo Pari<, California 94025 
(650) 308-7300 

20-1665019 
(IRS Employer 

Identification No.) 

(Address, including z.ip code, and telephone number, including area code, of Registrant's principal executive offices) 

David A. Ebersmau 
Chief Financial Officer 

Faccbook, Inc. 
1601 Willow Road 

Menlo Park, California 94025 
( 650) 308-7300 

(Name, address, including zip code, and telejlhone number, including area code, of agent for service) 

Gordon 1<. Onvidson, Esq. 
Jeffrey It Vetter, Esq. 
J ames 0. Evans, Esq. 
Fenwick & West LLP 
801 Cal iforn ia Street 

Mountain View, California 94041 
(650) 988-8500 

Please .wu/ copies of all commuulcatlous to: 
Theodore W. Ullyot, Esq. 

David W. Kling, Esq. 
Michael L. Johnson, Esq. 

Faeebook, Inc. 
1601 Willow Road 

Menlo Park, California 94025 
(650) 308-7300 

Willi11m 11. Kinman, Jr., Esq. 
Daniel N. Webb, Esq. 

Simi)SOn Thacher & BllrtlcU LLP 
2550 Hanover Street 

Palo Alto, California 94304 
(650) 251-5000 

Approximate date of commencement of proposed sale to the public: As soon as practicable after the effective date of this Registration Statement. 

If any of the securities being registered on this Form are to be offered on a delayed or continuous basis pursuant to Rule 41 Sunder the Securities Act, check the following 
box: 0 

If this Form is filed to register additional securities for an offering pursuant to Rule 462(b) under the Securities Act, check t.hc following box and list the Securities Act 
registration statement number of the earlier effective registration statement for tbe same offering. 0 

If this Form is a post-effective am endment liled pursuant to Rule 462(c) under the Securities Act, check the follow ing box and list the Securities Act registration statement 
number of the earlier effective registration statement for the same offering. 0 

[f this Form is a post-effective amendment filed pursuant to Rule 462(d) under the Securities Act, check the following box and list the Securities Act registration statement 
number of the earlier effective registration statement for the same offering. 0 

Indicate by check mal'k whether the registrant is a large accelerated filer, an accelerated filer, a non·accelcratcd liler, or a smaller reporting company. Sec the definitions of 
"large accelerated filer", "accelerated filer" and "smaller reporting company" in Ru le 12b-2 of the Exchange Act. (Check one): 

Large accelerated filer 0 
Non-accelerated filer IKI (Do not check if a smaller reponing company) 

CALCULATION OF REGISTRATION JIEK 

Title of Each Class of 
Securities to be Registered 
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Registered(!) 
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Estimated pursuant to Rule 457(a) under the Securities Act of 1933, as amended. Includes additional shares that the underwriters have the option to purchase to cover over­
allotmentS, if any. (2) Estimated solely for the purpose of calculating tltc registration fcc. 

(3) The Registrant previously paid $1,556,379 of the total registration fee in connection with prior filings of this Registration Statement 
(4) In accordance with Rule 4S7{a) an additional registration fee of $419,764 is being paid in connection with this amendment to the Registration Statement to register an additional 

96,391,003 shares. The additional registration fee has been computed based on the proposed maximum offering price of the additional shares included itt this amendment to the 
Registration Statement. 

The Registrant hereby amends this Registration Statement on such date or dates as may be necessary to delay its effective date until the Registrant shall file a 
further amendment which specifically states that this Registration Statement shall thereafier become effective in accordance with Section 8(a) of the Securities Act of 1933 
or until the Registration Statement shall become effective on such date as the Securities and Exchange Commission, acting pursuant to said Section 8(a), may determine. 
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The Information In this prospectus Is not complete and may be changed. Neither we nOt" the selling stockholders may sell these 
securities until the registration statement filed with the Securities and Exchange Commission is effective. This prospectus Is not an 
offer to sell these securities and neither we nor the selling stockholders are soliciting offers to buy these securities In any jurisdiction 
where the offer or sale Is not pef'mltted. 

PROSPECTUS (Subject to Completion) 
Issued May 16, 2012 

421,233, 615 Shares 
' . . . ' 

facetiook . 
' 

. . . 

CLASS A COMMON STOCK 

Facebook, Inc. is offering 180,000,000 shares of its Class A common stock and the selling stockholders are offering 241,233,615 shares of 
Class A common stock. We will not receive any proceeds from tlte sale of shares by the selling stockholders. This is our initial public 
offering and no public market currently exlsts for our shares of Class A common stock. We anticipate tltat tlte initial public offering price 
will be between $34.00 and $38.00 per share. 

We have two classes of common stock, Class A common stoclc alld Class B common stock. The rights of the holders of Class A common 
stock and Class B common stock are identical, except voting and conversion riglrts. Each share of Class A common stock is entitled to one 
vote. Each share of Class B common stock is entitled to ten votes and is convertibk at any time into one share of Class A common stock. 
The ltolders of our outstanding shares of Class B common stock will hold approximately 95.9% of the voting power of our outstanding 
capital stock following this offering, and our founder, Chairman, and CEO, Mark Zuckerberg, will hold Of' have the ability to control 
approximately 55.8% of the voting powef' of OUI' outftanding capital stock fol/Qwlng this offering. 

Our Class A common stock ltas been approved for listing on tlte NASDAQ Global Select Market Ullder tlte symbol uFB. " 

We are a "controlled company" under tlte corporate governa11ce rules jot NASDAQ-listed companies, and our board of directors ltas 
determined not to It ave a11 independent nominating function and instead to have tile full board of directors be directly 1'esponslble for 
nominating members of our board. 

Investing in our Class A common stock involves risks. See "Risk Factors " beginning on page 12. 

PRICE$ 

Price to 
Public 

A SHARE 

Ullderwrltlllfl 
DL�c()lu/1$ ami 
CommlssloiiS 
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We and the selling stockholders have granted the underwriters the right to purchase up to an additional 63, I 85,042 shares of Class A common 

stock to cover over-allotments. 

The Securities and Exchange Commission and state regulators have not approved or disapproved of these securities, or determined if this 
prospectus is truthful or complete. Any representation to the contrary is a criminal offense. 

The underwriters expect to deliver the shares of Class A common stock to purchasers on 

MORGAN STANLEY 

BofA MERRILL LYNCH 

CIT/GROUP 

JP. MORGAN 

BARCLAYS 

CREDIT SUISSE 

RBC CAPITAL MARKETS 

. 2012 
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• 2012. 

GOLDMAN, SACHS & CO. 

ALLEN & COMPANY LLC 

DEUTSCHE BANK SECURITIES 

WELLS FARGO SECURITIES 

http://www.scc.gov/ Archivesledga.r/data/132680 1/000 1 193 12512235588/d287954ds I a.htm[ 1/612014 4:45:48 PM] 
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http://www .eclipse.org/webtools/community/education/web/t320/Implementing a Simple Web 
Service. pdf 

http://www .ibm.com/developerworks/webservices/tutorials/ws-eclipse-javase 1 /ws-eclipse­
javase l.html 

Building SOAP Web Service in Java Using Eclipse 
https://www.youtube.com/watch?v=Vt971U7xNJs 

Ecosystem OData - the best way to REST, showing SAP, IBM applications using OData-bases 
REST services. 
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IBM and SOAP: 

http://www .eclipse.org/webtools/iprelated/ip _log_2007. htm I 
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Ecosystem 

Producers 

Consumers 

Live Services 

Sample Code 

Tutorials 

Producers 
OData producers are services that expose their data using the OData protocol. Below we have 

collected a list of key OData producers, which will continue to grow along with the OData ecosystem. 

You can use OData SDK (http://www.odata.org/libraries) to build your own OData producers. If you 

create or know of an OData producer not listed be sure to let us know via our new contribution page 

(http://www.odata.org/contribution). Telerik OpenAccess ORM 

(http:/ jwww.telerik.com/products/orm.aspx)tn mid-201 0 Telerlk released a UNQ implementation 

that is simple to use and produces domain models very fast. Built on top of the enterprise-grade 

Telerik OpenAccess ORM the LINQ implementation allows you to easily build an OData feed via a few 

easy steps by using the OpenAccess Visual Designer and the Data Services Wizard. For more info, visit 

www.telerik.com/odata (http:/ /www.telerik.com/odata) 

1 C: Enterprise built-in OData service (http://1 c­

d n.com/1 c_ enterprise/) 

http://www .odata.org/ecosystem/ 

1 C:Enterprise, leading 

platform for business 

automnation in Russia 

and CIS (more than 1M 

installations and 300k 

developers) now provides 

an OData service for 

access its data. 

4/l l/2016 
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Acumatica (http://www.acumatica.com) 

BrightstarDB (http://www.brightstardb.com/) 

Cloud Drivers (http://www.cdata.com/doud/) 

Data boom (https:/ /databoom.space) 

http://www .odata.org/ecosystem/ 

Page2 of9 

Acumatica is a cloud- and 

browser-based enterprise 

resource planning (ERP) 

solution. Business data 

and lists created in 

generic inquiries can be 

exposed as OData 

endpoints. 

A SQL Server Integration 

Services script for 

importing OData into 

SQL Server. 

The CData Cloud Drivers 

create bidirectional 

OData entrypoints to 

SaaS & on-premise data 

sources. Supports the 

creation of OOata feeds 

for a variety of popular 

data sources, including: 

QuickBooks, Salesforce, 

SharePoint, NetSuite 

CRM & ERP, Dynamics 

CRM, Twitter, MySQL, 

Oracle DB, SQLite, Excel 

Files, and more. 

Databoom is a BaaS 

(Backend as a Service) 

that uses OData and 

SPARQL for graph 

database access. 

4/1 1/2016 
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GeoREST (http:/ /code.google.com/p/georest/) 

Gizur OData server (https://github.com/gizur/odataserver/) 

IBM DB2 & lnfomix 

(http://www.ibm.com/developerworks/data/library/techartide/dm-

1205odata/index.html) 

Page 3 of9 

GeoREST is a web-centric 

framework for 

distributing geospatial 

data. It allows RESTful 

feature-based access to 

spatial data sources, 

including full editing 

capabilities, through a 

MapGuide server or 

directly via FDO. 

Open source OData 

server that exposes an 

OOata API from any 

MySQL database. The 

server also extends the 

OOata API with functions 

for managing users and 

privileges. In addition 

there is support for 

BLOBs. The server is 

currently in beta status. 

DB2 & lnformix can 

expose OData via 

Microsoft Visual Studio. 

IBM WebSphere eXtreme Scale WebSphere eXtreme 

(http://www.lbm.com/developerworks/webservices/library/standards- Scale can expose OOata 

odata/) enabling access from a 

variety of clients. 

JBoss Data Virtualization 

(http://www.redhat.com/en/technologies/jboss-middleware/data­

virtualization) 

http://www .odata.org/ecosystem/ 

JBoss Data Virtualization 

allows you to import 

OOata services and 

converts them to 

relational objects (tables 

and procedures). 

4/l l/2016 
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Lightswitch (http:/ /msdn.com/lightswitch) 

Microsoft Dynamics CRM 2011 (http://msdn.microsoft.com/en­

us/libraryfgg334279.aspx) 

Microsoft Dynamics NAV 2013 

(http://www.microsoft.com/dynamics/nav) 

OData Server (https://rwad-tech.com/en) 

http://www .odata.orglecosystern/ 

Page 4 of9 

Microsoft Visual Studio 

LightSwitch is a 

development 

environment designed to 

simplify and shorten the 

development of data­

driven businesses 

applications. Regardless 

of your development 

skills-whether you're a 

beginner or an 

experienced 

developer-LightSwitch 

enables you to quickly 

create professional­

quality business 

applications and data 

services. 

The latest version allows 

you to query using OData 

Business data in 

Dynamics NAV 2013 ERP 

solutions can be accessed 

as OData feeds. You can 

create "Self-service 81" 
solutions using 

PowerPivot for Excel to 

consume these feeds. 

Automatically generated 

REST server that exposes 

an OData above existed 

Microsoft SQL Server or 

MySQL database. The 

server also has access 

management features, 

such as users, roles and 

priviliges management 

and ready to use Ul 

project to perform these 

tasks. 

4/1 1/2016 
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Priority Software (http://www.priority-software.com/) 

Progress Data Direct Cloud 

(https://www.progress.com/products/datadirect-cloud) 

RemObjects Data Abstract 

http://www .odata.orglecosystem/ 

Page 5 of9 

Priority is an established 

ERP software available in 

the cloud or on premise 

and used by 7,000 

customers worldwide. 

Priority offers a full 

business management 

package that is rich in 

functionality, fully 

integrative, simple to 

implement and easy to 

maintain. All user screens 

and application data in 

Priority are exposed as 

OData URLs according to 

the OData API 

specification. 

Progress DataDirect 

Cloud is a data 

connectivity service that 

exposes SaaS application 

data (e.g. 

Salesforce.com), on­

premise relational data 

(e.g. Oracle), Big Data 

(e.g. Hadoop}, and 

NewSQL/NoSQL data 

(e.g. MongoDB) as an 

OData feed. 

full multi-tier database 

application framework 

that supports publishing 

data for insert, select, 

update and delete via 

OData. Server libraries 

for .NET, Mono (Linux & 
OS X) and Delphi 

4/11/2016 
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SAP NetWeaver Gateway (http://www.sdn.sap.com/irj/sdnjgateway) 

Page 6 of9 

SAP NetWeaver Gateway 

{formerly called "Project 

Gateway") is a technology 

that provides a simple 

way to connect devices, 

environments and 

platforms to SAP 

software based on 

market standards. It 

offers connectivity to 

SAP applications using 

any programming 

language or model 

without the need for SAP 

knowledge by leveraging 

OData-based REST 

services. 

SOL Tridion 2011 (http://www.sdl.com/enjwcmjproducts/sdltridion/) SOL Tridion is a Web 

Content Management 

solution, the Content 

Services component now 

supports OData 

SQL Server 201 2 

(http://www.microsoft.com/sqlserver/2008/en/us/reporting.aspx) 

http:/ /www.odata.org/ecosystem/ 

Microsoft SQL Server 

2012 Reporting Services 

can expose data from 

reports as OData 

4/1 1 /2016 
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Savigent Software Catalyst xM (http://savigent.com/) 

ScanJour WorkZone Content Server (http://scanjour.com) 

SharePoint (http:/ /office.microsoft.com/en­

us/sharepoint/collaboration-software-sharepoint-FX1 03479517 .aspx) 

http://www .odata.org/ecosystem/ 

Page 7 of9 

The Open Data Protocol 

provides easy access to 

Catalyst xM1� workflow 

execution history from a 

variety of off-the-shelf 

data mining and business 

intelligence tools and is 

an ideal choice to expose 

manufacturing 

intelligence from Catalyst 

xM™ to browser-based 

and mobile clients. The 

Catalyst xM Server 

Manager provides a Data 

Source Builder which 

allows users to configure 

virtual tables that are 

created dynamically to 

provide data access via 

the Open Data Protocol. 

ScanJour WorkZone is a 

Case and Document 

Management System 

which implements OData 

API for full manipulation 

of all data, cases and 

documents. 

Any data you've got on 

SharePoint as of version 

2010 can be manipulated 

via the OData protocol, 

which makes the 

SharePolnt developer API 

considerably simpler. 

4/1 112016 
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Sitefinity CMS by Telerik (http://www.sitefinity.com/) 

Team Foundation Server (http://www.microsoft.com/en· 

us/download/details.aspx?id=36230) 

Teiid (http:/ /teiid.jboss.org/) 

Telerik TeamPulse (http:/ fwww.telerik.com/tea m-productivity­

tools.aspx) 

http://www .odata.org/ecosysteml 

Page 8 of9 

The Sitefinity CMS by 

Telerik is ready to host 

OData services. With the 

powerful API, any 

developer can expose any 

information from the 

CMS through a custom 

OOata service. For more 

info, visit 

An extension to Team 

Foundation Server Server 

2010 and 2012 that 

allows you to browse TFS 

data using the OData 

protocol 

Teiid allows you to 

connect to and consume 

sources (odata services, 

relational data, web 

services, file, etc.) and 

deploy a single source 

that is available as an 

OData service out-of-the­

box. 

The Telerik TeamPulse 

Silverlight client interacts 

with the database using a 

WCF data service, and 

more specifically by using 

the Open Data Protocol 

which is a popular way to 

expose information from 

a variety of sources 

including, but not limited 

to, relational databases, 

file systems, content 

management systems 

and traditional Web sites. 

4/1 1/2016 
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Webnodes CMS (http://www.webnodes.com/odata) 

Windows Azure Table Storage (http://msdn.microsoft.com/en­

us/library/azurejdd 1 79423.aspx) 

tm2o - OData provider for Topic Maps 

(http:/ /code.google.com/p/tm2o/) 

Contribute to OData Ecosystem 

Page 9 of9 

Webnodes CMS is an 

enterprise quality 

ASP.NET CMS with a 

unique semantic content 

technology. Webnodes 

recently added OData 

support. Read more 

about it here. 

Windows Azure Table 

provides scalable, 

available, and durable 

structured storage in the 

form of tables exposed as 

OData endpoints. 

TM20 - which is a generic 

OData provider for Topic 

Maps. Internally tm2o 

leverages 0Data4J 

Want to add/update information of the OData ecosystem? You can edit and submit changes to this 

page on its Github repository (https://github.com/ODataOrgjodataorg.github.io}. 

© 2015 OData-The Protocol for REST APis 

http://www .odata.org/ecosystem/ 4/ l l /20 1 6  
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T320 E-business technologies: 
foundations and practice 

Block 3 Part 1 Activity 5:  I mplementing 
a simple web service 
Prepared for the course team by Neil Simpkins 

Introduction 

Components of a web service 

Implementation approaches 

Eclipse for Block 3 
Steps to a first web service 

Create a project 

Writing the service logic 

Generating a web service and client 

Testing the web service 

Using the client 

Monitoring web service messages 

Service descriptions 

Web service endpoint 

Axis and WSDL 

Summary 

Appendix 1 :  WSDL generated for 'Hello' web service 

Introduction 
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19 
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19 
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24 
24 

In this activity you will see how to use Eclipse to create and test a very simple web 
service. Before I look at the service itself, however, I shall provide some background 
information about the different approaches that can be used to develop a web service. 

Copyright© 2008 The Open University 

This document is made available under the Creative Commons Attribution - No Derivative 

Works 3.0 Unported Licence (http://creativecommons.org/licenses/by-nd/3.01) 

� c: 
::::> 
c: Ql c. 

0 
Ql .r::. ..... 

WEB 0071 1 2 1.1  
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T320 E-business technologies: foundations and practice 

Monitoring web service messages 
At the bottom of the Eclipse window, you will see that both the request put to the 
service and the response from the service are displayed in the TCP/IP Monitor. 
Eclipse displays these messages all on one line, but here is the request laid out more 
usefully: 

<?xml version= " l . O "  encoding= "UTF-8"?> 

<Soapenv: Envelope 
xmlns : soapenv= "http : / /schemas . xmlsoap . org/soap/envelope/" 
xmlns: xsd="http : //www . w3 . org/2001/XMLSchema" 
xmln s : xsi= "http : //www . w 3 . org/2001/XMLSchema-instance " >  
<Soapenv : Body> 

<helloName xmlns="http : // t 3 2 0 . open . ac . uk " >  

<name>Nick</name> 
< /helloName > 

< /soapenv : Body> 
</ soapenv :Envelope> 

You can see that this is a SOAP envelope with a fairly simple body element. The 
application's own namespace is constructed using the Java package of the Java 
class. If a proper unique Java package name was used then this is acceptable as the 
URI. 

The Java method name 'helloName' has been used as a SOAP tag enclosing another 
tag 'name', which is the name of the variable argument to the 'helloName' method. 

These conventions, of course, are restricted to uses of Java but other programming 
languages can use similar practices. 

The SOAP response is very similar, with only a slightly different body element: 

<?xml version="l . O "  encoding= " u t f - 8 " ? >  
<soapenv: Envelope 

xmlns: soapenv= "http : / / schemas . xmlsoap. org/soap/envelope/ "  
xmlns :xsd="http : / /www . w 3 . org/2001/XMLSchema" 
xmlns :xsi="http : / /www.w3 . org/2001/XMLSchema-instance"> 
<soapenv: Body> 

<helloNameResponse xmlns="http : / / t3 2 0 . open . a c . u k " >  
<helloNameReturn>Hello there Nick</helloNameReturn> 

</helloNameResponse> 
</soapenv :Body> 

</soapenv : Envelope> 

The web service has used a simple convention of appending 'Response' to the 
request tag 'helloName' and has appended 'Return' to this to label the method's 
returned result. 

Service descriptions 

Web service endpoint 
You have now completed the main steps for creating the simple 'Hello' web service. 
Before you shut down Eclipse, I want to take a quick look at some of the items that 
have been generated around the 'helloName' method you have invoked. 

Earlier I noted that the Methods pane in Eclipse lists three methods other than the 
'helloName' method that you created (see Figure 21). The endpoint of the web service 
is the URL where the service resides and can be accessed. If you click on 
'getEndpointO' and then on the 'Invoke' button, the URL will be displayed in the Result 
pane as http : /  /localhost: 8180/Hello/services/Hello. 

Block 3 Part 1 Activity 5 I 1 9  
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. -s:r.-:-,;­E;l IC7 Hello 

$·-�til Deployment Descriptor: Hello 
e--� Java Resources: src 

B W uk.ac.open.t320 
IB [D Hello.java 

i ffi a. Libraries 
l±l· (a, build 

8-(2:} WebContent 
ttl U META-INF 
e U WEB·INF 
8 llo wsdl 

: 1· IXJ "r:m•, j•[.j•.¥•4·11111 
$ ··l;t HelloCiient 

[fl·lO Servers 
1±1 (1 JSR-109 Web Services 

Figure 28 Location of 'Hello.wsdl' file i n  the 'Hello' project 

Summary 
In this activity you have been taken through the steps required to create, deploy (to an 
application server on your local machine) and test a simple web service. This is a 
significant step in understanding at first hand how SOA actually works. In subsequent 
practical activities you will deploy your web service to a server on the Internet, publish 
its description to a UODI registry, test its level of interoperability and be able to access 
and use it on the Internet. 

Appendix 1 :  WSDL generated for 'Hello' 
web service 

<?xml version= " l . O "  encoding="UTF - 8 " ? >  
<Wsdl : definitions 

targetNamespace= "http : //t32 0 . open . ac.uk" 
xmlns : apachesoap= "http://xml. apache . org/xml-soap" 

xmlns : impl="http : / / t 3 2 0 . open . ac .uk" 

xmlns : intf="http : //t320 . open . ac . uk" 
xmlns :wsdl="http : //schemas . xmlsoap . org/wsdl/ "  
xmlns : wsdlsoap="http : / /schema s . xmlsoap . org/wsdl/soap/" 

xmlns : xsd="http : / /www . w3 . org/2001/XMLSchema" >  

< ! - -WSDL created by Apache Axis version: 1 . 4  
Built on Apr 22, 2006 ( 0 6 : 55 : 48 PDT ) - - >  

<wsdl : types> 
<schema 

elementFormDefault= "qualified" 

targetNamespace="http : //t3 2 0 . open . a c .uk" 
xmlns="http : / /vrww . w3 . org/2001 /XMLSchema " >  
<element name= "helloName " >  

<complexType> 
<sequence> 

<element name="name " type= "xsd: stt·ing" /> 
< /sequence> 

< /complexType> 
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< /element > 
<element name="helloNameRespons e " >  

<complexType> 
<sequence> 

<element name= "helloNameReturn" type="xsd : string" / >  
</sequence> 

</complexType> 
</element> 

</schema> 

</wsdl : types> 
<wsdl : message name="helloNameResponse"> 

<wsdl :part element= " impl : helloNameResponse" name=" parameters" /> 
</wsdl :message> 

<wsdl : message name="helloNameRequest"> 
<wsdl:part element="imp l : helloName " name="parameters" /> 

</wsdl : message> 
<Wsdl : portType name="Hello " >  

<Wsdl : operation name="helloName" >  
<wsdl : input message="impl : helloNameRequest" name= "hel loNameRequest• / >  

<wsdl: output message= "impl :helloNameResponse" name="helloNameResponse" /> 
</wsdl : operation> 

</wsdl :portType> 

<wsdl: binding name="HelloSoapBinding" type = " impl :Hello"> 

<Wsdlsoap : binding 
style="document" transport= "http : //schemas .xmlsoap .org/soap/http" /> 

<wsdl : operation name="helloName" >  
<wsdlsoap : operation soapAction= " "  / >  
<WSdl : i nput name="helloNameRequest"> 

<wsdlsoap :body use="literal" / >  

</wsdl : input> 
<wsdl : output name="helloNameResponse"> 

<wsdlsoap: body use="literal" /> 

</wsdl : output> 
</wsdl : operation> 

</wsdl :binding> 
<wsdl : service name= "HelloService"> 

<wsdl : port binding="impl:HelloSoapBinding" name="Hello"> 
<wsdlsoap: address 

location="http : / /localhos t : 0180 /Hello/services/Hello" / >  
</wsdl:port> 

</wsd l : service> 

</lllsdl : definitions> 
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SECTION 2 :  Developing Mobi le  Apps 

APP ENHANCEMENTS WITH SDKS 

Third-party Software Development Kits 
(SDKs) make a good app great by 
enabling features and functions that are 
difficult to develop internally. The follow­
ing SDKs have proven track records and 
greatly improve the user experience. 

Augmented reality: .M.e.tai.o. and� 
are frameworks that allow an app to 
present contextual information. 
augmenting what the user can see using 
either location. image. or pattern 
detection. 

Immersion: Developers can add an 
immersive experience by adding a 
panorama or 3D element to the app. 
Apps developed with kw.arJ.Q have a 
360-degrees panorama. coupled with 
live video feeds (from onsite cameras) 
that gives the user a real-time overview 
of a given field of view and the ability to 
interact with it dynamically. Unity3d 
immerses users in a full 3D environment 
and lets them interact with different 
points of view. 

Communication: Developers can 
enhance the communication experience 
with SDKs such as OpeoTo�. which 
enables a live video chat functionality 
within the app. B.u.t:ni2 supports data 
exchanges between phones across 
platforms. 

These SDKs, and others, provide much of 
the consumer-grade functionality and 
rich user experience that end-users want 
in their apps for both work or personal 
use. 

14 

ADDING VALUE WITH DATA 

INTEGRATION 

Mobile apps become more valuable 
when they access data stored in back­
end systems. Proprietary interfaces and 
XML-based Web services expose this 
data for the apps. but neither is very 
mobile friendly. 

When planning data integration. you 
must determine what data should be 
exposed to clients. Finding the right 
balance is tricky. Exposing more data 
than is needed degrades the Ul perfor­
mance and battery; when not enough 
data is available. the app is less useful to 
the user. 

A host of interfaces. such as Web servic­
es. JOBS. REST. and OData. are available 
to connect the back-end system and 
mobile app. As mobile app development 
matures. OData is expected to become 
the leading protocol for connecting apps 
to the data in back-end systems. 

THE CASE FOR USING ODATA FOR 

DATA INTEGRATION 

Web Services architectures have evolved 
rapidly in the recent past. Early web 
Service Oriented Architectures (SOA) 
were based on SOAP. More recently. 
RESTful web services gained acceptance 
as a lighter-weight approach: REST has 
the reputation of being more easily 
consumed by mobile and dynamic web 
applications. Today. OData is an emerg­
ing web services standard. lt was origi· 
nally proposed by Microsoft and has 
been embraced by industry leaders. 
including SAP. 

OData defines an access layer atop a 
REST protocol and adds the following key 
capabilities to conventional REST 
services: 

• Defines a formal query language to 
dynamically select the best data set 
for a given task 

• Supplies integrated metadata 
descriptions of the data structures it 
exposes 

• Supports dynamic combining of 
related objects in a single result set 

• Supports paging for larger result sets 
• Allows for server-side searching of 

data content without constructing 
complex queries 

• Returns results in the developer's 
choice of XML or JSON data formats 

• Works with well-known mobile 
protocols including REST, HTIP, and 
HTIP-based security/authentication 
protocols 

The key strengths of OData lie in its 
dynamic nature. Data exposed via OData 
can be optimized directly by the applica­
tion developer without requiring back­
end services modifications. This saves on 
development time and cost by reducing 
the back-and-forth interactions between 
application and server development 
teams. An OData services approach also 
cuts testing costs by reducing the need 
for hand-crafted server code. 

til OData 
Visit OData org for the latest news and 
updates on OData. 

App Development in a Mobile World 
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Eclipse Project Release Notes 
Release 2.0.1 
August 26, 2002 

This software is OSI Certified Open Source Software. 
OSI Certified is a certification mark of the Open Source Initiative. 

1 .  Target Operating Environments 
2. Compatibility with Previous Release 
3. Known Issues 
4. Defects Fixed 

1 .  Target Operating Environments 

Most of the Eclipse SDK is "pure" JavaTM code and has no direct dependence on the underlying operating 
system. The chief dependence is therefore on the Java 2 Platform itself. The 2.0 release of the Eclipse 
Project is written and compiled against version 1.3 of the Java 2 Platform APis, and targeted to run on 
either version 1 .3  or 1.4 of the Java 2 Runtime Environment, Standard Edition. 

Eclipse SDK 2.0 has been tested and validated on the following Java 2 Platform implementations: 
-

Operating 
system 

-

Microsoft® 
Windows® 

.--,-

Linux 

·--

Sun Solaris 

- - - -IHP HP-UX 
- --IIBM®AIX 

.�.
-- - -· 

Processor [Java 2 Platforms I architecture 
- -- --

Sun Java 2 SDK, Standard Edition, version 1 .3 . 1  for 
Microsoft Windows 

·- --

Intel x86 IBM Developer Kit for Windows, Java 2 Technology 
Edition, version 1 .3.0 

- -

s� Java 2 SDK, Standard &!ition, version 1 .4 for I Microsoft Windows 
- - -

Sun Java 2 SDK, Standard Edition, version 1 .3 . 1  for 

Intel x86 

-- -

Linux x86 
- --

IBM Developer Kit for Linux, Java 2 Technology 
Edition, version 1 .3.0 

- -- - --

Sun Java 2 SDK, Standard Edition, version 1 .4 for 
Linux x86 

-

Sun Java 2 SDK, Standard Edition, version 1 .3 . 1  for 

SPARC 
Solaris SPARC 

-

Sun Java 2 SDK, Standard Edition, version 1 .4 for 
-

Solaris SPARC 
- - -llh 9000 PA-RISC J HP-UX SDK for the Java 2 platform, version 1 .3. 1 

p __ _ 

for hp9000 P�_:::RISC 

IIPower:c J IBM Developer Kit for AIX, Java 2 Technology 
Edition, version 1 .3.0 

-. -- -
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The following table describes the combinations of operating system and Java 2 Platform used when 
testing the Eclipse SDK configurations. The status column indicates the level of testing: "Primary" means 
a full tested configuration; "Secondary" means a configuration which is only lightly tested; "Untested" 
means a configuration that has received no testing, but which should work. Note that the Linux GTK 
configuration is considered early access for the 2.0 release; it has been tested, but is not product quality 
in this release. 

Window Java 2 Platform 
system (see above table) 

·-

Win32 Windows on Intel x86 

. -

I 
Linux on Intel x86 

Motif lsolaris on SPARC 

IHP-UX on hp9000 PA-
RJSC 

-

-

l�rx o� PowerPC 
-

GTK Linux on Intel x86 

Internationalization 

- -!operating Environment I Testing Stat�s 

!Windows 2000 ]!Primary l 
!Windows XP J�rimary I 
jWindows ME J�econdary I 
!Windows 98S� ���condary . I 
!Windows NT ]lsecon_dary I 
IRedHat Linux 7.2 x86 ]!Primary � 
�uSE Linux 7.3 x86 .JIPrimary 
Other Linux; kernel version 2.4.7, and !untested XFree86 versiOn 4 . 1 .0 

- -- -· 

]lsun Solaris 8 SPARC 

liHP-UX l l i  hp9000 
- · 

JlmM AIX 5.1  on PowerPC 
IRedHa� Linux 7.2 x86 GTK 2.0 
lsuSE Linux 7.3 x86 GTK 2.0 

-

]!Primary 

IIPrimary 

JIPrimaty_ 
]!Early access 

]!Early a�cess 

Other Linux; kernel version 2.4. 7, and Early access; 
GTK 2.0 untested 

--

I 
l 
l 
I 

__ ] 
J 
J 

The Eclipse Platform is designed as the basis for internationalized products. The user interface elements 
provided by the Eclipse SDK components, including dialogs and error messages, are externalized. The 
English strings are provided as the default resource bundles. 

Latin-1  locales are supported by the Eclipse SDK on all of the above operating environments; DBCS and 
BIDI locales are supported by the Eclipse SDK only on Windows operating environments. 

The Eclipse SDK supports GB 1 8030, the new Chinese code page standard, on Windows 2000 and XP 
only. Note that GB 1 8030 also requires locale and character encoding support from the Java 2 Runtime 
Environment; this support is standard in version 1 .4, and also available in some 1.3 JREs. 

German and Japanese locales have been tested. 

BIDI support 

The Eclipse SDK 2.0 is a development environment targeted at technical professionals - not an end user 
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application. However, the Eclipse SDK 2.0 tools will permit technical professionals who are working in 
English to build Hebrew/ Arabic end user Java programs which are themselves not based on the Eclipse 
SDK. The BIDI support in the Eclipse SDK 2.0 allows a Java programmer to work with BIDI strings, 
code comments, etc. but the Eclipse SDK itself is not designed to be localized for BIDI locales and its 
widget orientation can not be changed. 

IMPORTANT- The above BIDI support is available only on Windows platforms. 

2. Compatibility with Previous Release 

The Eclipse SDK 2.0 is upwards compatible with the Eclipse SDK 1 .0 to the greatest extent possible. We 
have made exceptions in areas where slavishly maintaining compatibility would not be in the best 
interests of the Platform or its clients. These exceptions are noted below, so that clients can assess the 
impact of these changes on their plug-ins and products. 

API Contract Compatibility: The Eclipse SDK 2.0 is upwards contract-compatible with the Eclipse 
SDK 1 .0 unless noted. This means that programs in full compliance with contracts specified in the 
Eclipse SDK 1 .0 APis will automatically be in full compliance with the Eclipse SDK 2.0 APis. (API is 
construed broadly to include such things as plug-in extension points.) Downward contract compatibility 
is not supported There is no guarantee that compliance with the Eclipse SDK 2.0 APls would ensure 
compliance with the Eclipse SDK 1 .0 APis. 

Binary (plug-in) Compatibility: The Eclipse SDK 2.0 is upwards binary-compatible with the Eclipse 
SDK 1.0 unless noted. This means that plug-ins built for the Eclipse SDK 1 .0 will continue to work 
correctly in the Eclipse SDK 2.0 without change. Downward plug-in compatibility is not supported. 
Plug-ins for the Eclipse SDK 2.0 are unlikely to be usable in the Eclipse SDK 1 .0. Plug-ins with hard­
coded references in their plug-in manifest file to 1.0 versions of prerequisite Eclipse Project plug-ins will 
not work in 2.0 as the plug-in version numbers will be incompatible. 

Source Compatibility: The Eclipse SDK 2.0 is upwards source-compatible with the Eclipse SDK 1 .0 
unless noted. This means that source files written to use the Eclipse SDK 1 .0 APis can be successfully 
compiled and run against the Eclipse SDK 2.0 APis. Since source incompatibilities are easy to deal with, 
maintaining source compatibility is considered much less important than maintaining contract and binary 
compatibility. Downward source compatibility is not supported. If source files use new Eclipse SDK 
APis, they will not be usable with an earlier version of the Eclipse SDK. 

Workspace Compatibility: Eclipse SDK 2.0 is upwards workspace-compatible with Eclipse SDK 1.0 
unless noted. This means that workspaces and projects created with Eclipse SDK 1.0 can be successfully 
opened by Eclipse SDK 2.0 and upgraded to a 2.0 workspace. Individual plug-ins developed for Eclipse 
SDK 1 .0 should provide similar upwards compatibility for their workspace metadata; plug-in developers 
are responsible for ensw·ing that their plug-ins recognize 1 .0 metadata and process it appropriately. Note: 
the interim Eclipse SDK 1.0 plug-ins (ones with provisional APis) are unlikely to automatically upgrade 
their metadata to 2.0. User interface session state may be discarded when a workspace is upgraded. 
Downward workspace compatibility is not supported. A workspace created (or opened) by Eclipse SDK 
2.0 will be unusable with an earlier version of Eclipse SDK. 

Note on non-compliant usage: All non-API methods and classes, and certainly everything in a package 
with "internal" in its name, are considered implementation details which may vary between operating 
environment and are subject to change without notice. Client plug-ins that directly depend on anything 
other than what is specified in the Eclipse SDK API are inherently unsupportable and receive no 
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guarantees about compatibility within a single release much less with an earlier release. Refer to How to 
Use the Eclipse API for information about how to write compliant plug-ins. 

Platform - UI 

The public client API has been kept stable with the exception of ITextViewer interface which changed in 
an incompatible way: 

• Added method ITextViewer. invalidateTextPresentation ( )  
• Added method ITextViewer .  setDefaul tPrefixes (String[] defaul tPrefixes, String 

contentType) 
• Removed method ITextViewer. setDefaultPrefix(String defaultPrefix, String contentType) 

Platform - Debug 

The debug API has been completely reworked for 2.0. The new APis are not compatible with the 1 .0 
APis, which were all considered "interim". 

The high level API differences between the new and old debug platforms are: 

• Breakpoints - In 1 .0, breakpoints were implemented as markers. In 2.0, breakpoints are 
implemented as objects (interface !Breakpoint), with an associated marker used for presentation in 
editors, and persistence of attributes. There is a new extension point for registering types of 
breakpoints: org. eclipse.debug. core.breakpoints. 

• Launch Configurations - In 1.0, an !Launcher was used to launch applications. In 2.0, the concept 
of a "launcher" has been replaced with a launch configuration. There are new extension points to 
register launch configuration types, and for comparing launch configurations 
(org . eclipse . debug . core. launchConfigurationTypes, 
org . eclipse. debug. core . launchConfigurationComparators ). The associated interfaces are 
IlaunchConfigurationType, IlaunchConfiguration, ILaunchConfigurationWorkingCopy, and 
IlaunchConfigurationDelegate. 

• Launch Configuration Tab Groups - In 1 .0, wizards were registered with launchers for launch 
related UI. In 2.0, the launch configuration dialog and launch shortcuts replace launch wizards. 
The associated extension points are org. eclipse. debug. ui .launchConfigurationTabGroups, 
org. eclipse. debug. ui . launchConfigurationTypeimages, and 
org. eclipse. debug. ui .launchShortcuts. The associated interfaces are 
IlaunchConfigurationTabGroup, ILaunchConfigurationTab, and iLaunchShortcut. 

• Debug model API changes - Interfaces defining the debug model elements have been modified, 
and new debug elements have been added to support procedural debug and expression 
management. 

As well, the Java debug model API has been enhanced and changed to reflect changes in the debug 
platform. 

Platform - Core 

Eclipse 1.0 Core Target Management was provisional. For 2.0, Core Target Management has been 
withdrawn and replaced by team target management providers. These new target management facilities 
are early access, and are contained in the Eclipse FTP and WebDAV Support feature (separately 
installable). 
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Platform - Help 

Help APls and extension points were marked as interim in Eclipse 1 .0. Based on the initial feedback, the 
Help APis and extension points have changed significantly in Eclipse 2.0 and are not compatible with 
those in Eclipse 1 .0. 

Platform - Scripting 

Eclipse 1 .0 Scripting support was provisional and incomplete. For 2.0, the Scripting component has been 
withdrawn completely from the Eclipse Platform. 

Platform - Install/Update 

The InstalVUpdate component API has been completely reworked for 2.0. The 1 .0 notion of component 
has been replaced in 2.0 by the notion of a feature. The new APis are not compatible with the 1 .0 APis, 
which were all considered "interim". 

Platform - Team 

Workspace compatibility from VCM CVS 1 .0 to Team CVS 2.0: the meta information for CVS providers 
has considerably changed from 1.0 to 2.0, and the meta information is not being preserved. To ease 
migratio� some automation of migrating CVS repository locations is provided, and some helpful steps 
have been included. These are described in the Team CVS FAQ. 

PDE 

Extension point schema file extension changed 

Extension point schema file extension has been changed from * .xsd to * .exsd to avoid conflicts with 
XML schema editors and/or non-PDE schema files. PDE will still detect files with the old extension and 
will issue a warning about the change. 

Support for components removed 

Eclipse 2.0 Install/Update has discontinued the use of components in favor of features. Consequently, 
PDE 2.0 supports feature-related development while component supp01t has been removed. Features are 
described in the Eclipse Platform Plug-in Developer Guide. 

3. Known Issues 

3. 1 Platform 
3.1.1 Core 
3.1 .2 Ant 
3.1 .3 Help 
3 . 1 .4 UI 
3 . 1.5 SWT 
3 . 1 .6 Team 
3 . 1 .  7 Instal1/U pdate 
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3.2 Java Development Tools (JDT) 
3.3 Plug-in Development Environment (PDE) 
3.4 Other 

3.4. 1  FTP and WebDAV support 

Note: Bug numbers refer to the Eclipse project bug database at http://dev.eclipse.org/bugs/ 

3.1 Platform 

Eclipse process does not exit (HP-UX only) 

On HP-UX, the HP JVM process that runs the Eclipse Workbench does not terminate upon closing the 
workbench. The remedy is to always pass the -XdoCloseWithReadPending to the VM via the Eclipse 
launcher command line; that is, launch Eclipse with the command line: 

eclipse -vmargs -XdoCloseWithReadPending 

(bug 18321) 

3.1.1 Platform - Core 

Invalid characters in install directory prevents Eclipse from starting 

Eclipse will fail to launch if installed in a directory whose path contains certain invalid characters, 
including :%#<>"!. The workaround is to install Eclipse in a directory whose path does contain invalid 
characters. (bugs 3 109, 1 7281) 

Problems with classloaders in created threads 

There is a known issue with trying to load classes from a newly created thread using a class loader 
different from the plug-in class loader. The result will be a ClassNotFoundException. As a workaround, do 
the following: 

1 .  Create a thread in which to run your code. 
2. Send yourThread.setContextClassLoader(yourClassLoader); II you can find your classloader by 

grabbing a class it loaded (YourPluginClass.class.getClassLoader()) 
3. Run your code in the newly created thread. 

If you set the context class loader for the current thread, you are competing with other users of the thread 
(all of Eclipse), so the results will be unpredictable. (bug 8907) 

Deadlock creating executable extension in Plugin.startup 

If Plugin. startup code is too complex and performs tasks such as creating an executable extension, a 
deadlock situation can be created. Only simple bookkeeping tasks should be performed in 
Plugin. startup code. (bugs 12827, 5875, 16141)  

3.1.2 Platform - Ant 
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System.exitO in Ant task causes Eclipse to crash 

If an Ant script is run as an external tool or using the Run Ant pop-up menu, it runs on the same Java 
VM as Eclipse. If the running script execute any Ant task that calls System .exit(int), Eclipse exits and 
any unsaved work is lost. A workaround for these Ant tasks is to configure Ant as an external tool. The 
following steps show how this is done: 

(bug 17487) 

1 .  Download and install the binary version of Ant from 
http://jakarta.apache.org/ant 

2. Click Run > External Tools > Configure. 
3. Click New. 
4. Enter a name for your external tool (for example, "External Ant"). 
5. Click Browse File System. 
6. Find and select a file called ant. bat (it should be in the bini folder of your 

Ant installation). 
7. In the Tool Arguments field enter the arguments for your script that 

would normally enter for running the script outside of the Workbench. 
8. In the Working directory field enter the directory of your script. 
9. Click OK to exit the wizard. 

10. To run the script, click Run > External Tools > External Ant. 

3.1.3 Platform - Help 

Help documents not displayed in a browser or very slow document loading (Windows only) 

If your LAN settings are not properly configured for local host access, your Help browser might open to 
a blank page or display an HTTP error instead of a help page, or you may experience long delays when 
loading help documents. Your system administrator can configure your LAN settings so that help 
documents can be accessed from the local help server. 

1 .  In the Control Panel, open Internet Options, select the Connections tab and choose 
LAN Settings. 

2. If your host was configured to use DHCP for IP assignment, make sure that the 
"Automatically detect settings" check box is cleared. 

3.  If you use proxy server, ensure that the "Bypass proxy server for local addresses" is 
selected. 

4. In "Advanced" settings for proxies, add "127.0.0.1 ;1ocalhost" to the "Exceptions" if 
these addresses are not listed. 

5. If you are using an automatic configuration script for proxy settings, and are not sure 
that the script is correct, clear the "Use automatic configuration script" check box. 

If the above steps do not fix your problem, try changing the port and host properties in 
org . eclipse. tomcat\preferences. ini. In general, setting host=localhost or host=127. e .  e . 1  should 
work. Also, especially when running a firewall, you may want to set port=Be or some other firewall­
friendly value. (bugs 7036, 94 1 8, 1 1394) 

Working disconnected from the network (Windows only) 
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If you are experiencing problems when not connected to the network you must install the loop back 
adapter from the Windows installation CD. (bug 831) 

Using Internet Explorer in offline mode (Windows only) 

If you have been using Internet Explorer in Offline mode, when you access the help system, you will get 
a message indicating that the web page you requested is not available offline. Click Connect to return the 
system behavior to normal. 

Opening and navigating Help produces clicking sound (Windows only) 

Internet Explorer has a sound event associated with navigate events. To tum this sound off, go to Control 
Panel -> Sounds ->Windows Explorer and change the sound for "Start Navigation" to "none" in the 
menu box. (bug 16081) 

Keyboard navigation in help using Mozilla 

Accessibility support is limited in pre-1.0 releases of the Mozilla browser. If you need to navigate help 
using the keyboard, you must upgrade to Mozilla version 1.0. (bug 15018) 

Searching help produces unexpected results and highlights incomplete words 

For some languages, a stemming algorithm is used to enhance the chance of a search hit. For these 
languages, the word roots are searched for; exact searches are not supported. As such, the result set 
contains documents with variations of the search query words, and only the common roots are 
highlighted in the document. Stemming and stop word removal also applies to search query terms 
enclosed in quotation marks ("), so the search results will not be an exact match of the quoted string. (lmg 
1 7030) 

3.1.4 Platform - UI 

Manual refresh required when files modified outside Eclipse 

When files within a project are added or removed outside of Eclipse, or when an external editor is used to 
modify a file within a project, a manual refresh must be done in order for the changes to show up in the 
Workbench. To do this, select the project in the Navigator view and choose Refresh from the pop-up 
menu. This refreshes only the selected project. Alternatively, activate the Navigator view and press F5, 
which refreshes all projects. 

Dirty state not tracked properly for OLE documents (Windows only) 

The dirty state for an OLE document is not updated properly. This causes it to prompt to save the 
contents when the document is closed, even if the contents have already been saved. 

OLE document crashes can cause Eclipse to also crash (Windows only) 

If an OLE document crashes, this can cause Eclipse to either crash, or to have workbench menus become 
inconsistent. 
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Minimum display resolution 

A number of dialogs in Eclipse, such as the Preferences dialog, require a minimum display resolution of 
at least 800 x 600. (bug 5549) 

External Tools will automatically quote path variables containing spaces 

When an external tool is launched, expanded path variables that contain spaces will be enclosed in 
double quotes ( " ). While it is typical for Windows executables to expect paths containing spaces to be 
quoted, this is known to cause problems on platforms such as Linux which do not expect these quotes. A 
workaround is to make the external tool a script which strips off the quotes before launching the 
executable with those parameters. (bug 20599) 

Default text file encoding may be detected incorrectly (Windows XP/2000 only) 

The "Text file encoding" value displayed in the Preferences dialog under "Editors" may be wrong on 
platforms running Windows XP (or 2000) when the user locale and system locale differ. 

Example of the manifestation of the bug: A Japanese user using Japanese Windows 2000 works in New 
York, United States. The user has selected English (United States) as the user locale. The ''Text file 
encoding" value displayed by Eclipse is incorrect: "Cp1252" (English). It should display the system 
locale "MS932" (Japanese). 

Workaround: The user can modify the user locale so that user locale and system locale are identical. In 
the example above, this means the user should set Japanese as the user locale. Then restart Eclipse. The 
"Text file encoding" value will then be correct: "MS932" (Japanese). 

For Windows XP: 

• To check the system locale: Open the Control Panel. Go to Regional and Language Options. 
Switch to the Advanced tab. The system locale is specified in "Language for non-Unicode 
programs". 

• To change the user locale: Open the Control Panel. Go to Regional and Language Options. The 
user locale can be modified by changing the language in "Standards and formats". 

For Windows 2000: 

• To check the system locale: Open the Control Panel. Go to Regional Options. Look up the items in 
the General tab, inside the "Language settings for the system" group. The system locale is the item 
marked as (Default). 

• To change the user locale: Open the Control Panel. Go to Regional Options. The user locale can be 
modified by changing the location in "Settings for the current user". 

(bug 2064 .I) 

Preferred Output Level on External Tools preferences page has no effect 

In Window > Preferences > External Tools, there is a group of radio buttons under the heading 
"Preferred Output Level" with possible options of "Information", "Verbose" and "Debugn. Changing 
these values does not affect Eclipse in any way. Workaround: when running an Ant script, use the Ant 

file:J//C :AJsersJiarunachalam/Desktop/IBMComplaintAprii172016JEclipse%20Project%20Release%20Notes%202.0.1.html 9126 



Case 1:16-cv-00281-UNA   Document 1-4   Filed 04/20/16   Page 44 of 83 PageID #: 7244/17/2016 Eclipse Project Release Notes 2.0.1 

command line arguments -verbose or -debug to get an output level other than the default ("Information"). 
(bug 208 17) 

Updating the toolbar in multi-page editors 

Clients of action bars may create a number of SubToolBarManagers on their IToolBarManager (e.g., 
multipage editor). The client will typically make one SubToolBarManager visible, the rest invisible, and 
call updateActionBars. The visibility of the items may not update correctly. 

A workaround is for the client to explicitly update the toolbar: 

actionBars. updateActionBars( ) ;  
actionBars. getToolBarManager( ) . update(false); 

(bug 20988) 

3.1.5 Platform - SWT 

Available colors on 8-bit Linux (Linux only) 

Typically, in Gnome Linux installs running with 8-bit visuals (i.e. 256 color mode), before the Eclipse 
application is started you already do not have any free colors. This may mean that Eclipse is unable to 
allocate the default widget background color, causing it to display a white background. The functionality, 
however, is otherwise unaffected. 

Printing support (Linux only) 

The X printing extension implementation on Linux is currently disabled because it can take up to 7 
seconds to determine that the X print server is not running. Until this is rectified, 
Printer .getPrinterlist( )  will always return an empty array on Linux. (bug 882 1) 

Disposing in a focus event 

Applications should not dispose widgets in focus changing events. Doing so on Motif may cause Eclipse 
to terminate, since Motif accesses the disposed widget within their internal focus change event handler. A 
similar (but less serious) issue exists on Windows and occasionally results in an SWT exception being 
thrown. 

List and ComboBox on Windows NT (Windows NT only) 

On Windows NT only, you should avoid creating items in a List or comboBox with strings longer than 
1000 characters. Doing so may result in a General Protection Fault. This has been fixed in more recent 
versions of Windows. 

BiDi support 

The StyledText widget provides bidirectional language support for Hebrew and Arabic locales. Currently 
this support is available only on Windows and has several known problems. 

Cursor constructor arguments 

In the constructor Cursor(Device device� ImageData source� ImageData mask� int hotspotx� int 
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hotspotY), when both a source and mask argument are specified (that is, the mask is not null), the 
meaning of the two arguments is reversed. That is, the "mask" argument should be the source image and 
the "source" argument should be the mask image. (hug 4809) 

Using ffiM J9 VM (Photon and AIX) 

On QNX Photon and ffiM AIX, the SWT library will not be found when running with an IBM J9 1.5 
VM. This is a bug in the ffiM J9 class library in version 1.5. You can workaround this problem by adding 
the SWT library directory to your LD _LIBRARY_ PATH environment variable. 

Missing permissions for SWT native libraries in workspace (HP-UX only) 

When retrieving the SWT Motif fragment into an Eclipse workspace, the permissions of the native 
libraries are reset. This creates a problem on HP-UX because shared libraries need to have execute 
permission. Attempting to self-host with this fragment throws an UnsatisfiedLinkError ... Permission 
Denied error. You must manually change the permissions to make these libraries accessible (assume the 
workspace is at /workspace): 

cd /workspace/org. eclipse . swt.motif/os/hpux/PA_RISC 
chmod 555 * . sl 

(hyg 20305 describes a related problem) 

Javadoc not consistent across platforms 

Because of a bug in the way we updated the javadoc in SWT source code, the javadoc for protected 
methods is not consistent across platforms. The javadoc for the Windows platform, which is used to 
generate the documentation that appears in the Platform Plug-in Developer guide, is the defmitive source. 
The javadoc for the other window systems will be brought into line in a future release. (hug 20968) 

JAWS requires MSAA for List Views to read checkboxes in Tables (Windows only) 

In order for JAWS to detect the checkbox information in Tables, MSAA support for List Views must be 
activated as follows: 

1 .  Open Eclipse and hit INSERT + F2. 
2. In the Run JAWS Manager dialog select Configuration Manager. 
3. In the Jaws Configuration Manager that opens up, select Set Options and then select 

Advanced Options. 
4. Check "Rely on MSAA for List views". 
5. Hit the OK button. 
6. Choose File > Save from the menu bar. 

No accelerators or mnemonics on Solaris (Solaris· only) 

The Solaris implementation of Motif has a long-standing bug with respect to adding and removing 
accelerators and mnemonics. The behavior is such that the time to do so becomes increasingly longer 
ea.ch time it occurs, to the point that, in Eclipse's case, it can take more than a minute to switch between 
editors and views! Because of this, accelerators and mnemonics are explicitly ignored on Solaris. 
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3.1.6 Platform - Team - CVS 

Note: Additional information on how to use CVS from Eclipse can be found in the Eclipse CVS FAQ. 

"extssh" is not a supported command line method 

Since the "extssh" connection method is not a supported command line method, you cannot use the 
command line tool when a project uses this method. Instead, use the Eclipse supported "ext" method and 
set the appropriate environment variables so that the command line tool will work. (bug 7943) 

Connection cannot be found after initially missing 

If a connection initially fails due to a network problem, the connection may continue to fail  even when 
the network problem is fixed. In order to establish the connection you must exit and restart Eclipse. (bug 
9295) 

CVS meta-folders appear in some cases 

There are some cases where CVS folders are not hidden from the UI as the user would expect. For 
instance, CVS folders will appear if a user imports a CVS project into Eclipse before the CVS plug-in is 
loaded. To avoid this, open the CVS Repositories view (thus loading the CVS plug-in) before importing 
CVS projects into Eclipse. (bug 12386) 

"Received broken pipe signal" error from server 

Eclipse sometime performs multiple commands within a single connection to the server. This may cause 
problems with CVS servers that are running server scripts in response to certain commands. (bug 15490) 

"Terminated with fatal signal lO" error from server 

There is a bug in the CVS server related to some compression levels. If you get this error, changing the 
compression level on the CVS preference page may help. (bug 1 5724) 

Team > Update does not indicate that there are outgoing changes 

The Team > Update command will load all remote changes into your local working copy. If you are 
using Team > Update and you want to see which files have outgoing changes, open the CVS console 
before performing the update. The console will show the results of the update (which files had mergeable 
conflicts, which ones had unmergeable conflicts and which ones had outgoing changes). Warning: Only 
use Team > Update if you know CVS. Ifthere are "real" conflicts (i.e., those that affect the same line of 
a file) then CVS will add markup to the file during the update. Resolving these conflicts in this manner is 
not pleasant. (bug 16750) 

Synchronize view "Mark as Merged" has surprising behavior with respect to modes 

When you Mark as Merged, if its your only incoming change and you are in the incoming mode, the 
sync view becomes empty. On the surface it looks like the change is gone. However, your change will 
appear in outgoing mode. (bug 18513) 
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Team > Commit on an unchanged file does not update decorator 

If you perform a Team > Commit on a file that has been modified but whose contents match the contents 
of the file on the server, the file will remain on outgoing change. To correct the problem, either perform a 
Team > Update or use the Synchronize view to commit. (bug 18647) 

Change ASCII/Binary Properties not available for unadded files 

The Change ASCII/Binary Properties menu item is only enabled for files and folders that are under 
CVS control. If you want to set the keyword substitution mode for a new file, you will need to add it to 
version control first. (bug 191 83) 

Error updating incoming directory additions with pruning turned off 

If pruning is turned off and a project has incoming nested folder additions that do not contain any files, 
performing an update in the Synchronize view will result in an error (cannot create folder). The 
workaround is to perform a Team > Update which will bring in the directories. (bug 19442) 

"Remove from View" in Synchronize view does not exclude resources from view actions 

If you remove one or more resources from the Synchronize view using the Remove from View menu 
item, these resources will no longer appear but they will still be included in any performed operations 
(Update, Commit, etc.) (bug 19538) 

Ctrl-S does not save in Synchronize view and CVS compare views 

Ctrl-S does not perform a save in the workspace resource editor in the Synchronize view. Instead, use the 
popup menu and choose Save. (Pug 20327) 

CVS automatically prunes empty directories 

By default, empty directories will be pruned on checkout and update. This is desirable in most cases as 
directories on a CVS server are never deleted. However, if this causes problems, there is a CVS 
preference to disable auto-pruning. (bug 20463) 

ClassCastException on attempt to replace directory with file 

Performing the following steps will result in the above exception: 

1 .  Create a new project & share it with a CVS repository. 
2. Create a directory in the project root and a file inside this directory. 
3. Synchronize the project using Team > Synchronize with Repository. 
4. Locally delete the directory (and contained file) that was just created 
5. Create a file in the project root with the same name as the directory that was just deleted. 
6. Synchronize again using Team > Synchronize with Repository. 

The workaround is to commit the folder deletion before creating the new file. (Pug 20906) 
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Still prompted if delete unmanaged preference turned off 

If the "delete unmanaged resources on replace" preference has been disabled on the Team > CVS 
preference page and a Team > Replace With operation is performed on a project that has one 
unmanaged resource and no other outgoing changes, the user is prompted to overwrite local changes 
even though the operation will not overwrite the unmanaged resource. (bug I 8834) 

Hidden CVS/ folders get copied when copying folders from one project to another 

If you copy a folder that is under CVS control to a folder that is not, the cvs; folders (usually not shown) 
will be copied as well. This can cause problems if the target project is under CVS control and you try to 
add the moved folder to CVS control. The workaround is to manually delete the CVS/ subdirectmies using 
the file system browser, or disconnect the source project from CVS control before copying the folders. 
(bug 2062 1 )  

Update with incoming deletion and addition involving file with different case fails (Windows only) 

On update, if there are incoming deletions for one or more files and incoming additions for files of the 
same name with a different case, then the operation may fail on Windows depending on what order the 
server sends the files in. Workaround is to update the deletions first and then the additions using the 
Synchronize view. {Qug 2 1 001) 

3.1.7 Platform - Install/Update 

Migrating 2.0 pre-release workspaces 

When migrating an existing workspace that was used with a 2.0 pre-release version of Eclipse (e.g., 
created with development drops obtained directly from eclipse.org, or updated via the Eclipse update 
manager prior to 2.0 release), it is strongly recommended that you start with a fresh install of Eclipse 2.0, 
and delete the . config/ subdirectory of the . metadata/ directory located in the workspace you are 
migrating (<workspace> 1 .  metadata/. config/) before reopening the workspace. (bug 16456) 

Not enough space for temporary files 

If you get the error "java.io.IOException: There is not enough space in the file system." but still have 
plenty of space in the selected install location, check to make sure that you also have sufficient space in 
the standard location where temporary files are created. (bug 17787) 

Workbench non-responsive while attempting to connect 

If the connection to an update site does not respond (the site does not exist or is down), the workbench 
becomes non-responsive until the connection request times out. Once the time out is reported, you will be 
able to continue. (bugs 18598, 19775) 

Processing pending "downgrades" 

Natively-installed feature changes are automatically detected on workbench startup. If this change is a 
downgrade (that is, the newly detected version of a feature is older that one already configured), you will 
be prompted whether you'd like the change applied; even when you say Yes, the change will not actually 
be applied, and the currently configured newer feature will remain configured. If the downgrade was 
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intentional, open Help > Software Updates > Update Manager, and from the Install Configuration 
view, choose Show Disabled Features, explicitly enable the lower version and explicitly disable the 
newer version. (bug 16502) 

Local JAR files are locked 

While processing update sites in the local flle system (for example, by exploring My Computer), some of 
the feature JAR files may be left open while the workbench is active, and will not be available to other 
applications. Exit and restart the Eclipse to correct this condition. (bug 1 5594) 

Wrong status being reported for unconfigured or missing features 

If you select Show Status for a feature that is unconfigured or missing, the resulting dialog erroneously 
claims "The feature is configured properly". (bug 19932) 

Accessing update sites through a proxy 

To access an update site through a proxy, you will need to start the workbench with the following 
command line options: 

eclipse -vmargs -DproxySet=true -DproxyHost�<proxy_name> -DproxyPort=<proxy_port> 

as documented in Java World Tip 42. Proxies requiring user authentication are currently not supported. 
(bug 197 1 7) 

URL validity checking on input 

URL syntax is currently not completely checked on input. Ensure that any entered URLs use the correct 
separators (eg. forward slash '/') and do not contain invalid characters. (bugs 1 9685, 20247) 

Running "headless" applications that do not handle restart 

When install changes are detected, the changes are automatically processed and the workbench restarts. 
The executable launcher supplied with the application correctly handles the restart. However, if you have 
applications that directly call the platform (eg. by calling the BootLoader APis) and do not handle restart, 
the startup reconciliation processing can be suppressed by specifying -noupdate command line option. In 
this case, the application will start with the set of features and plug-ins that were processed and 
configured on the previous start. If prior configuration cannot be found, the application will start with the 
full set of plug-ins found in the installation location. 

3.2 Java Development Tools (JDT) 

Running Java programs with non-Latin-1 characters in package or class names 

You get a java .lang. NoClassDefFoundError when running Java programs with non-Latin characters in the 
package or class names. The workaround is to package the class files as a JAR file and run the program 
out of the JAR and not from the file system directly. (bug 4181)  

Missing debug attributes 

The debugger requires that class files be compiled with debug attributes if it is to be able to display line 
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numbers and local variables. Quite often, class libraries (for example, "rt. jar") are compiled without 
complete debug attributes, and thus local variables and method arguments for those classes are not visible 
in the debugger. 

Setting breakpoints 

In general the debugger will not allow you to place breakpoints on lines of code that are not executable 
(comments, blank lines, etc.). However, there are some cases where the debugger will allow breakpoints 
on lines of code that are not executable. For example, the debugger will allow a breakpoint to be placed 
on a variable declaration that does not contain an initializer ("int x;"). Note that enabled breakpoints 
which are successfully installed on an executable line in a running ( debuggable) VM are displayed with a 
checkmark. Breakpoints that are displayed without a check.mark are not installed in a running 
(debuggable) VM . 

Using Hot Code Replace 

Hot code replace is supported on JDK 1 .4.x VMs, and IBM J9 VMs. Hot code replace is limited to 
changes which do not effect the shape of a class. That is, changes within existing methods are supp01ted, 
but the addition or removal of members is not supported. 

Hot code replace and stepping on JDK 1 .4.0 VMs is unreliable. This appears to be a VM issue that 
should be fixed in later releases of the JDK. 

Scrapbook 

Setting a breakpoint inside a scrapbook page is not supported. 

When a snippet is run in the scrapbook which directly or indirectly calls System . exit(int), the 
evaluation cannot be completed, and will result in a stack trace for a 
com. sun . jdi.  VMDisconnectedException being displayed in the scrapbook editor. 

Terminating a scrapbook page while it is performing an evaluation results in a 
com. sun. jdi . VMDisconnectedException being displayed in the scrapbook editor. 

Debugging over slow connections 

A global Java debug preference specifies the debugger timeout, which is the maximum amount of time 
the debugger waits for a response from the target VM after making a request of that VM. Slow 
connections may require that this value be increased. The timeout value can be edited from the Java > 
Debug preference page. Changing the timeout value only effects subsequently launched VM, not VMs 
that are already running. 

Updating of inspected values 

When inspecting the result of an evaluated expression in the debugger, it is important to note that the 
result displayed is the result of that expression at the time it was evaluated. For example, when inspecting 
a simple integer counter (primitive data type), the value displayed in the Expressions view is the value 
when the expression was evaluated. As the counter is changed in the running program, the inspected 
result will not change (since the view is not displaying the value bound to a variable - it is displaying the 
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value of an expression, and the value of a primitive data type cannot change). However, if an expression 
results in an object, fields of that object will be updated in the inspector as they change in the running 
program (since the value bound to fields in an object can change). 

Stepping over native methods that perform 110 

When the debugger steps over native methods that perform 1/0 to System. out or System. err, the output 
may not appear immediately unless the native performs a flush on the output buffer. 

VM and process termination running on IBM 1.3 JVM on Linux (Linux only) 

Terminating a launch, debug target, or system process associated with a debug target running on the IBM 
1 .3 JVM on the Linux platform does not work when the associated debug target has a suspended thread. 
To remove such debug targets from the debug UI, select Terminate and Remove from the debug view's 
pop-up menu (or use the shortcut "delete" key). Associated system processes in the OS may not be 
properly cleaned up. If a debug target has no suspended threads, termination works properly. 

Searching for constant field references 

Search does not find references to constant fields inside binaries because the Java Language 
Specification mandates that constant field values be inlined in the class file's bytecodes, leaving no trace 
of a field reference. (bug 12044) 

Java compilation units outside of the build class path 

When a compilation unit with compilation problems is moved outside the Java build class path, it retains 
its Java problems forever (its compilation problem list does not get refreshed because it will never be 
compiled again). Renaming a *.java file to one with another a different file extension suffix causes the 
same problem. (bug 1 3008) 

Refactoring operations update references in the entire workspace 

Refactoring operations always update references in the entire workspace. This can be more than what is 
needed and expected. For example, when you have the same project twice in your workspace and you 
perform a rename refactoring in one of the projects, then the references in the other project will be 
updated as well. 

Actions to modify read-only files 

Actions on the Source menu (e.g., Generate Getter and Setter) are always disabled when the file is 
read-only. This is currently true even when the repository provider supports automatically checking out 
files on modification. (bug 17600) 

Java code templates 

You cannot use ${CURSOR} inside of a comment in a Java code template (Window > Preferences > Java 
> Templates). (bug 19556) 
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Organize import and imports from default packages 

Organize import does not handle imports from default packages. Note that importing from a default 
package is no longer supported in JDK 1 .4. Qrng 19487) 

Add Javadoc action for fields 

The Add Javadoc action does not work for fields. (bug 20259) 

Javadoc hover in the Java editor 

The Javadoc hover help shown when hovering over identifiers in the Java editor does not handle links 
inside of Javadoc comments properly. (bug 20644) 

3.3 Plug-in Development Environment (PDE) 

Comments in source pages of PDE XML editors 

PDE provides a number of multi-page editors that include a raw source page. Editors that handle XML 
files (plug-in, fragment and feature manifests) will preserve comments in most cases. However, 
comments will not be preserved if added before the root XML element, or if added after the last child 
element contained in the parent element. (bug 8000) 

Clipboard operations in the property view 

Clipboard shortcuts (Ctrl+X, Ctrl+C, Ctrl+V etc.) do not work in cell editors of properties that belong to 
the PDE Plug-in Manifest Editor. Use pop-up menu to activate these operations. (bug 13776) 

Problem while importing fragments 

If a workspace contains binary projects for a plug-in and a fragment that references that plug-in, fragment 
libraries are added to the class path of the referenced plug-in project. When an attempt is made to 
overwrite the plug-in and the fragment with versions from another build, deletion of the old fragment 
may fail. If that happens, repeat the operation to repair the workspace. Only the affected plug-in and 
fragment need to be re-imported. (bug 16921) 

Assumption that output is in bin/ folder 

PDE assumes that all plug-in and fragment projects that contain Java code have one or more source 
folders and build output in the bin/ folder. Although it is possible to change the name of the output folder 
in Properties dialog, the PDE run-time workbench launcher does not work correctly for those plug-ins. 
(bug 1 7444) 

Preferences not working with import/export 

Preferences set in PDE preference page called Target Platform are not preserved the same way as other 
preferences. Consequently, they are not subject to Impmi/Export operations in the Preferences dialog. 
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(bug 19688) 

Clipboard operations do not work in the Feature Manifest Editor 

GUI pages of the Feature Manifest Editor support pop-up menus that contain standard clipboard 
operations (Cut, Copy, Paste). However, none of these operations work for structural widgets (trees and 
lists). The only place where these operations do work is in text widgets in Information and Source page 
(bug 20460) 

Choosing Compute Build Path causes J'ava project to no longer build 

PDE computes the build class path of a plug-in project by looking up source mappings in the 
build. properties file. This file defines how source folders are compiled into runtime libraries. In the 
absence of this file, PDE will compute the class path that contains no source folders, resulting in 
compilation errors. The required build. properties file is generated by PDE when a new plug-in project 
is created. If the plug-in project is created in some other way, a build. properties file must be added 
manually. See the PDE Guide for details on the format of build. properties files. (bug 9765) 

ECLIPSE_HOME produces fragile class paths due to version numbers in plug-in directory paths 

Eclipse products are typically built so that plug-ins are located in the same directory and each plug-in is 
in the directory whose name includes both a plug-in id and a version id (e.g., "org.eclipse.ui_2 . e .e"). If 
external plug-ins are used while self-hosting, these plug-in directory names show up in POE-generated 
class paths. These class path are sensitive to plug-in version changes and must be recomputed if the target 
platform uses different version numbers. (bug 1 5 199) 

Plug-in import wizard does not allow plug-ins of different versions to be imported 

The Eclipse platform allows two plug-ins with the same ID but different versions to coexist if the only 
thing they contribute is run-time libraries. However, PDE cannot handle these plug-ins because it creates 
project names using plug-in IDs during binary project import. (bug 1 8500) 

PDE nature required for plug-in manifest syntax checking 

PDE will only be able to provide syntax checking and error/warning markers for plug-in manifests if the 
plug-in project has the PDE plug-in nature. A plug-in project automatically gets this nature when created 
by a PDE wizard. This situation can only occur if a regular Java project has been used to host a plug-in. 
The problem can be fixed by converting it into a PDE project. (bug 19248) 

PDE does not preserve original manifest file layout 

When non-Source page of a PDE manifest editor is used, PDE will convert changes back into XML by 
regenerating the file. Although the overall content and the comments are preserved, the actual f:tle layout 
is not. This may cause problems by showing false changes during file compare. If file layout is 
important, perform all editing in the Source page. Alternatively, avoid using Source pages altogether. 
Since XML files are generated in a way that respects and preserves the relative order of major elements 
(extensions, extension points etc.), changes made in a non-Source page of a PDE manifest editor do not 
result in false deltas during file compare. (bug 19251) 
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Go To Line in manifest editor causes Outline view to go blank 

When the Source > Go To Line command is invoked in the Source page of a PDE manifest editor, the 
Outline view will become gray. Since the Source page does not have a functional outline, there is no 
actual loss offunction. (Qug 19361) 

New Feature wizard does not generate build.properties file 

When creating a new feature project, the PDE wizard does not automatically generate a 
build. properties file. As a result, building the feature will create a feature JAR without any content. To 
work around this, create a build. properties manually using the instructions provided in the PDE Guide. 
(Qug 201 1 8) 

Update Classpath attaches source from the wrong Eclipse install 

Java libraries are associated with source code according to source code locations specified in a PDE 
preference. By default, these locations are registered by plug-ins of the design-time Eclipse instance. If 
the target platform is not the same as the design instance, the source code provided by these plug-ins will 
not be in sync with the libraries. The workaround is to uncheck the default locations and define new 
source code locations that point to the source-bearing plug-ins in the target Eclipse installation. (bug 
20578) 

No way to specify plug-in library type 

PDE manifest editors do not provide widgets for specifying run-time library types as being either "code" 
or "resource". The only way to specify this attribute is to add it manually in the source page. (bug 20757) 

Run-time libraries exported through more than 2 plug-ins not in classpath 

If a plug-in requires a runtime library exported through more than two plug-ins, it is not automatically 
added to the compile class path when generating the build. xml file. Example: Plug-in A export its 
libraries, plug-in B requires plug-in A and re-exports A, plug-in C requires plug-in B and re·exports B. If 
plug-in D requires plug-in C, when generating the build. xml file, plug-in A libraries will not be added to 
the compile path even though they will be available at runtime. The problem can be worked around as 
follows:: 

1 .  Generate a build. xml using PDE (select the plugin. xml file and click Create Plug-in 
JARs) 

2. Edit the build. properties and add the following line: 
custom = true 

3. Add the missing JARs to the classpath of the javac task in build. xml. 

(bu�: 201 1 9) 

3.4 Other 

3.4.1 FTP and WebDAV support 
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When mapped to a target, the project folder is ignored 

Ignoring the project folder is by design. Normally with target management you put/get the contents of the 
project, not the actual project. The place you pick in the site explorer is where the project contents will 
go. This allows your local project to have a different name than the container in the WebDAV/FTP server. 
If you want to map several projects to the same site location, you create a new folder for each one. This is 
why "New Folder" is in the mapping page. (bug 17657) 

When setting the target site of a project, reselecting the same location gives misleading warning 

Using Deploy > Target Site on a project that is already deployed and selecting the same target site 
produces a scary overwrite warning. In this case, the warning can be safely ignored. (bug 17707) 

FTP messages cause an exception 

With some servers, the FTP client may receive messages that it did not anticipate. These will cause an 
exception. Trying the operation again usually works. (bug 1 8 1 08) 

FTP problems with spaces in resource names 

FTP does not work properly when file or folder name contains spaces. (bug 20220) 

FTP problems retrieving remote timestamps with NT server 

Problems have occurred with some servers (NT server Serv-U FTP-Server v2.5k ) when trying to obtain 
the timestamp of a newly uploaded file. This causes a "ftle does not exist" error. The workaround is to 
Synchronize again and continue. (bug 1 97 1 5) 

4. Defects fixed 

4.1 Release 2.0.1 over 2.0.0 

Release 2.0.1 is a maintenance release to fix serious defects present in release 2.0.0. These changes only 
affect some plug-ins and features. Modified plug-ins have version id "2.0.1 "; plug-ins unchanged since 
the 2.0 release still have version id "2.0.0". Note, however, that all features now have version id "2.0. 1 "  
(even if  none of their plug-ins changed). 

Service release 2.0.1 fixes the following defects in release 2.0.0: 

ID 

1243� 

12463 

12906 

1 2266 

13226 

Summary 

Usability: Cannot resize navigation frame 

Plugin.find(IPath path, Map override) searches wrong directo 

[Editor Mgmt] If file is already opened in one editor, canno 

Remote debugging with Sun J2ME Wireless Toolkit fails 

JFace Text Editor Leaves a Black Rectangle on Content Assist 
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15229 
15559 

15984 
171 12 

17944 

1 8253 

183 1 8  

1 8585 

18927 
18994 

19502 
19686 

19702 

19780 

19964 

20067 
20153 

20260 

20412 

20430 

20480 

20679 
20686 

20725 

20752 
20753 
20797 
208 11 

208 1 9  

20865 

20866 

20879 
20887 
20927 

20947 

Eclipse Project Release Notes 2.0.1 

View errors when launching with out the plugins needed to cr 

JAWS reads the parent window for dialog shells 

Activating help does not bring help window to front 

[External Tools] Should be able to run external tools asynch 

Sync info on source of project move lost 

Coolbar - disposing items not honoring setRedraw = false 

Empty folders created when ugrading Eclipse 

Search stops if fail to contact site 

Copied scrapbook page uses some "old" information 

Typos 

Accessibility: sometimes focus is now drawn around the topic 

hover help stops working after mousing over end of file 

Feature: Have comment/uncomment actions in context menu [cod 

Table columns not distributing correctly in properties page 

Coolbar - can "lose" items when platform widget wraps 

Revert/ Restore are "instant" 

Export into JAR incorrectly references old description file. 

TVT2: corrupted characters in java prefs page 

TVT2: Mnemonic characters displayed in error message 

[Cell Editors] DialogCellEditor in the PropertySheet bases i 

Optimize writing of the registry cache file 

TARGET: FTP download fails with deep directory structure 

Install handlers are not being called on revert operations 

JavaBuilder.toString can throw NPE 

TVT2: Mnemonic showing in Runtime tab of Manifest editor 

Update manager does not preserve file pennissions 

[External Tools] Need to fix up quoting of variables contain 

Refresh does not work in Update Manager 

[External Tools] Ant ui does not handle ENTITY entries in al 

nullPointerException being thrown by Class Type.resolveBindi 

Feature without 1icense cannot be disabled. 

TVT2: clashing mnemonics in JUnit launcher 

Topic tree collapse behavior 

ProgressMonitorDialog truncates message 

[External Tools] Cannot run shell script file with a space 
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21010 

2 102 1 

21033 

2 1 036 

2 1 040 

2 1 04 1  

2 1 082 

21 088 

2 1 1 1 6 

21 1 18 

2 1 170 

21 1 71 

2 1 173 

21192 

2 1 1 97 

21198 

2 1 203 

21210 

2 1 230 

21268 

2 1 291 

2 1 292 

2 1 294 

2 1305 

21306 

2 1308 

21348 
2 1 3 6 1  

2 1 370 

2 1 376 

2 1 390 

2 1 4 19 

21436 
2 1447 

21465 

Eclipse Project Release Notes 2.0.1 

Use getAdapter when converting !Java Thread to JDIThread 

F 1 fix made too late 

TVT2: Clashing mnemonics in Java -> Editor panel 

RepositoryProvider.project stale if project renamed/moved 

[Update] Need a way for a user to set default editor when n 

[Update] Force welcome page first time a new feature is inst 

Cannot save in Compare with Revision editor 

TVT2: CannotSync displayed in help instead of proper dialog 

Can't compile because eclipse says that the method is not vi 

no mnemonics for Replace, Replace Selected 

NPE in RuntimeClasspathEntry if internal sow·ce archive remo 

Spelling error in "New Java Project" dialog box 

Can't create new Project because empty string in "New Projec 

Unsatisfied.LinkError thrown when pressing a hardware key 

Don't hard code the editor id names for the ManageBreakpoint 

On JavaEditor dont use = in the isActivePartO method but i 

Compile time NullPointerException in catch blocks 

Packages view Infopop message is not helpful [package explor 

Rebuilding project fails with ContextStackOverflow (Compilat 

StyledText - Ctrl+Shift+ J inserts line 

Team Examples require missing plugin org.eclipse.webdav 

Renaming (refactoring) boolean variables isX renames to getX 

issue more appropriate message when workbench already runnln 

Debug element rendering can be more robust 

IDI client does not tolerate null thread from events 

Method.isObsoleteO broken for method ID 0 on JDK < 1 .4 

duplicate eclipseurl jar in help.webapp plugin 

no support for optional features 

WordPattemRule freezes editor 

Takes long time for help browser to close. 

Breakpoint Properties: Add Class, Package missing ' ... ' 

Infocenter does not work on WAS 

CVS Quick connect to dev.eclipse.org - only when PDE availab 

Wrong method invoked at runtime 

Plugin Resolving - reorder REQUIRES clause & different plugi 
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21480 
21483 

2 1486 

21487 

21488 

21501 

2 15 18  

21557 
21580 

21595 
21606 

21614 

2 1 640 

2 1669 

21 672 

2 1 674 

2 1676 

2 1 686 

2 1 717 

21749 

2 1750 

21754 

21757 

21761 

21764 

21768 

2 1775 

2 1778 

2178 1 

2 1 828 

2 1829 

2 1834 

21845 
21882 
2 1883 

Eclipse Project Release Notes 2.0.1 

Bytecode disassembler doesn't handle #invokespecial correct! 

Error from ClassPrepareEvent when debugging WTK 

Resources opened in wrong editor when changing the default 

Infocenter: servlet classes not found. 

Infocenter ClassCastException in Xerces 

helpwebapp assumes it is deployed under plugins directory 

Debugger source lookup problem when debugging against Wirele 

VM bug prevents valid Java code to be executed on VM < 1 .3 . 1  

Verify Error in 1.4 compliant mode 

Need ability to get target information 

lmageBuilder deletes & adds rather than overwriting 

Keyring file cannot be read using IBM 1 .4.0 JRE 

Show types action in Variables view is confused 

-listener results in ClassCastException 

Wrong location for the last 'return' bytecode command 

-kkv default keyword substitution preference is not correct! 

Readme tools example should not use Ctrl+R 

[Coolbar] Perspective minimizes its cool items 

Null Pointer Exception in EditorWorkbook.java 

Exported libraries and source folders 

Plugin disabled after Feature update 

typo in IType::getSuperlnterfaceNames javadoc 

ast: incorrect range for Name in TypeDeclaration 

[Tasks] NPE refreshing the the task list view 

[Coolbar] Use minimumSize of preferred size for items 

ast: incorrect length of SimpleName in MethodDeclaration 

[External Tools] Allow external tool builders to run on spec 

ClassFileReader fails on Gnome Twain class 

NPE restarting after disabling feature (EditorManager.findlrn 

Possible problem in DoStatement#acceptO( ... ) 

API needed to allow CCombo to display its list at the prefer 

Coolbar - deleting items corrupting layout 

<topic> tag doesn't like labels with &Lt;xxx&gt; 

[Coolbar] Cool item position should be persisted 

[Coolbar] Removing last cool item in row should remove row 
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21885 

21 9 16  

2 1 9 1 7  

21941 

21953 

22055 
22064 

22093 

22 1 1 8  

22 142 

22 144 

22191 

22196 

22290 

22320 

224 1 8  

22422 
22448 

22556 

22561 

22571 
22607 

22681  

22683 

22691 

22740 

22779 

Eclipse Project Release Notes 2.0.1 
[Action sets] Support for toggle buttons and combo boxes in 

VariableDeclarationExpression 

Request for new API on AntRunner 

NotPresentException in TestSuite wizard [JUnit] 

Typo in error message "sychronized" 

CoolBar - setWraplndices causes rows to collapse/expand unne 

Install Handlers not run with -initialize flag 

Verify Error due to duplicate access method 

[Decorators] Decorators for !Resource ignores adaptable flag 

[Cool bar] Reset Perspective and original order bug 

Coolbar - setSize not being honored after setWraplndices API 

When adding a new feature with the Update Manager the user g 

Quick Fix broken due to bug 21768 [quick fix] 

Running Infocenter as Web Application in WebSphere 4.0 Advan 

Coolbar - delete item behavior problem 

Should not complain about package for empty units 

[External Tools] NPE running external tools builder 

CoolBar - deleting first item in row does unnecessary collap 

Crash during startup. 

Hover Help broken in 2.0.1 1200208 1 5  

Duplicate container resolution 

[Wizards] Wizards do not show icon for error, warning when s 

[Wizards] 2.0.1: regression: Bug with rendering of wizard er 

[Dialogs] 2.0.1 regression: Dialog borders differed (too big 

Verification Dialog contains non translated string 

Infinite prompt to close editor 

Eclipse linux-motif GPFs on exit on 19 

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other 
countries, or both. 

ffiM is a trademark of International Business Machines Corporation in the United States, other countries, 
or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in 
the United States, other countries, or both. 
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Other company, product, and service names may be trademarks or service marks of others. 

(c) Copyright IBM Corp. and others 2002 
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